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Note from the Developer 
This manual is not a guide on catch estimation methods. This manual is designed to 
describe how to properly use the MERCI system to enter survey data and to generate 
catch estimates. In other words, this manual illustrates how to do things and explains the 
available options but does not tell you when or why you should do them. 
 
Survey design and other statistical considerations associated with catch estimation for the 
Fraser River Native fishery are topics discussed in detail in: 
 

Alexander, C. A. D. 1999. 1998 Native Catch Estimates on the Upper Fraser 
River. Prepared by ESSA Technologies Ltd., Vancouver, BC for the Department 
of Fisheries and Oceans, Fraser River Division, Annacis Island, New 
Westminster, BC. 68 pp. and appendices. 
 
Alexander, C. A. D. 1998. 1998 Catch Estimates on the Lower Fraser River. 
Prepared by ESSA Technologies Ltd., Vancouver, BC for the Department of 
Fisheries and Oceans, Fraser River Division, Annacis Island, New Westminster, 
BC. 52 pp. 
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CHAPTER 1 

Before You Start 

1.1 Introducing MERCI 
Welcome to MERCI version 2.0 – a tool for Management and Evaluation of 
River Catch and effort Information. With this tool, you will be able to 
generate weekly catch estimates that can be used on a real time basis to assist 
in-river fisheries management decisions. This section introduces the major 
concepts underlying the creel survey design supported by MERCI, and the 
major steps required to use MERCI for analysis purposes. 

 
This section also describes the system requirements, installation instructions, 
and other important information you need to get started. 

1.2 Using this Guide 
This User’s Guide has all the information you need to work with MERCI. 
The chapters are arranged 
 

Chapter Describes 

Chapter 1 
Before You Start 

Describes MERCI and highlights some new 
features in version 2.0. It also outlines the 
conventions used in the Guide. 

Chapter 2  
Getting Started 

Describes how to install, start up and 
navigate through MERCI. 

Chapter 3 
General Features 

Provides instruction on how to access the 
general features that are the building blocks 
of the data entry forms. 

Chapter 4  
Data Entry 

Provides instruction on how to fill out the 
data entry forms. 
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Chapter Describes 

Chapter 5  
Estimation 

Provides options for aggregating survey data 
over both space and time. 

Chapter 6 
Runs 

Describes how to define catch estimation 
scenarios and execute the catch estimation 
algorithm. 

Chapter 7 
Model Output 

Describes the on-screen output options 
available in MERCI. 

Chapter 8 
The Database 

Describes the MERCI database and how to 
explore it. 

Chapter 9  
File Management 

Describes File Management features such as 
importing and exporting records between 
different databases. 

 

1.2.1 Document Conventions 
The Guide uses the following typographical conventions. 
 

Example Description 

drive_letter Italic type indicates a place holder for information you 
must provide, as well as names/text appearing on the 
screen such as the names of fields in dialog boxes. 

setup Bold type indicates text you must type exactly as 
shown. Bold type also emphasises menu options and 
buttons you must choose. 

CLOSE Small caps emphasize menus and the names of dialog 
boxes. 
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1.3 Highlights of MERCI 2.0 
MERCI v.2.0 was preceded by two major releases–version 1.0a and 1.1. 
MERCI v.2.0 represents a considerable advance over these previous versions 
in a number of areas. 
 

Feature MERCI 1 MERCI 2 

Normalised Access database ! !!!! 

Integrated estimation scenario-output 
management 

! !!!! 

Standard error and confidence limit 
algorithms 

! !!!! 

Streamlined user interface n/a !!!! 

Database to database Import/Export 
(raw survey data only) 

! !!!! 

Survey component updating (e.g., 
support for management unit additions) 

24-hour 
access sites 

only 

!!!! 
(except gear 

types) 

Password protected data 
deletion/updates 

! !!!! 

Comprehensive estimation options some !!!! 

Robust error checking !!!! !!!! 

Robust error handling ! !!!! 

Output graphics some more 

Survey data explorer !!!! !!!! 
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1.4 Getting Help 
Many of your questions about MERCI can be answered by consulting the 
table of contents of this User’s Guide. Technical support questions can also 
be addresses to Clint Alexander at the Vancouver office of ESSA 
Technologies Ltd.: 
 
Telephone: 604.733.2996 
Fax: 604.733.4657 
E-mail: calexander@essa.com 
 
We are very interested in your comments and feedback. 
 
Additional information about the creel survey design supported by MERCI 
can be found in the following documents: 
 

Alexander, C. A. D. 1999. 1998 Native Catch Estimates on the Upper 
Fraser River. Prepared by ESSA Technologies Ltd., Vancouver, BC for 
the Department of Fisheries and Oceans, Fraser River Division, Annacis 
Island, New Westminster, BC. 68 pp. and appendices. 
 
Alexander, C. A. D. 1998. 1998 Catch Estimates on the Lower Fraser 
River. Prepared by ESSA Technologies Ltd., Vancouver, BC for the 
Department of Fisheries and Oceans, Fraser River Division, Annacis 
Island, New Westminster, BC. 52 pp. 

 
 

mailto:calesander@essa.com
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CHAPTER 2 

Getting Started 

This chapter outlines the minimum system requirements to operate MERCI 
and describes how to install MERCI on your computer. It also provides 
information on how to start up and navigate the main MERCI window. It 
includes the following topics: 
 

• System Requirements 
• Installation Instructions 
• Running MERCI 
• MERCI Menus 
• Viewing the toolbar and status bar 

 

2.1 System Requirements 
The recommended system requirements for running MERCI are: 
 

• Pentium class processor, 200 MHz or better strongly 
recommended 

• A monitor capable of 1024 x 768 resolution or better 
• 64+ MB RAM (128 MB is ideal) 
• Hard-disk space: 

- 100 MB hard-disk space for intra-season survey data entry 
(when starting with a ‘fresh’ database) 

- 1+ gigabyte(s) for performing, storing, and evaluating results 
of alternative catch estimation scenarios with bootstrap 
confidence limits (i.e., master database). 

• CD-ROM drive 
 
The program runs under a 32-bit operating system such as Windows NT (4.0) 
or Windows 95/98. Access to, and familiarity with Microsoft Access 97, will 
significantly improve analysis flexibility. 
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2.2 Installation Instructions 
To install MERCI on your computer: 
 

1. Remove any previous installations of MERCI from your 
computer (being sure not to delete the associated MERCI 
database files). 

2. Place the MERCI2 installation CD in your CD-ROM drive. 

3. In Windows NT or 95/98 CONTROL PANEL choose 
Add/Remove Programs, 

OR 

from the START MENU select Run and then type 
drive:\setupex.exe. 

OR 

Using Windows NT or 95/98 EXPLORER, navigate to the 
MERCI2 CD and double click setupex.exe 

4. If prompted, click Install, otherwise simply follow the 
on-screen instructions. 

5. Read the “ReadMe.txt” file once set-up is complete. 
 
During installation, MERCI copies a default database to the directory you 
choose to install the model (“MERCI data entry template.mdb”). This 
database file, and a copy of the master database as of June 7, 1999 (“Fraser 
River Native Catch Database (master).mdb”) can also be copied directly 
from the MERCI2 CD. The MERCI2 CD also contains a copy of the 1998 
post-season review of the upper Fraser River Native catch estimation 
program. 
 
Note: MERCI v.2.0 will not function correctly with the MERCI v.1+ 
database format (non-normalised). MERCI v.1+ survey information can be 
imported into the new database format (normalised) as described in chapter 
9.2. 
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2.3 Running MERCI 

2.3.1 Starting MERCI 
MERCI is installed to run from the Windows NT or 95/98 START MENU. 

To start running MERCI: 

1. From the START MENU select Programs. 

2. Select Merci. 

3. Select MERCI_2. 
 
The first time you run MERCI after installation you are prompted to enter a 
password. MERCI requires a password as a safeguard to prevent the user 
from accidentally modifying or deleting data. Be sure to write down the 
password in a secure location in case you forget it. This password can be 
changed later. 

 
 

To enter a password: 

1. Type a minimum five-character password in the Enter 
Password field. 

2. Retype the password in the Confirm Password field to confirm. 

3. Click on the OK button to add the password or click on the 
Cancel button. 
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2.3.2 Navigating the MERCI Screen 

The MERCI Window 

The MERCI window is your workplace. The menu bar and toolbar are 
located at the top of the window, below the title bar. The status bar is at the 
bottom of the window. 
 

 
 
You operate MERCI by choosing options from the menus in the menu bar. 
You can also access some of the most frequently used menu options by 
clicking buttons in the toolbar. The menu options and toolbar buttons are 
described in more detail below. 
 

MERCI Menus 

Menu What you can do 

File Open, save, import and export databases and exit MERCI. 

Edit Access the General Features, Data Entry forms and 
Estimation options required for generating catch estimates. 

Run Allows you to define a catch estimation scenario. 

View Allows you to view basic catch estimation output and 
explore the MERCI database. 

Help Provides you with the version of MERCI and how to obtain 
technical support. 
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Viewing the Toolbar 

The toolbar, displayed below the menu bar in the MERCI window, provides 
quick access to the dialog boxes you use most often. These are the tools in 
the toolbar: 
 

Button Name What You Can Do 

 Open Database Opens the LOCATION OF FRASER RIVER 
CATCH DATABASE dialog box to allow 
you to select the database to open. 

 Save Database Saves the open database 

 Print Allows you to print the current view 

 Explore Database Takes you to the CATCH AND EFFORT 
EXPLORER where you can browse through 
the database 

 Update Graphs Takes you to the OUTPUT OPTIONS dialog 

 Exit Application Allows you to exit the program. 

 
You can display or hide the toolbar by doing one of the following: 
 

To Do this 

Display the toolbar From the View menu, choose Toolbar 

Hide the toolbar From the View menu, choose " Toolbar 

 

Viewing the Status Bar 

The status bar, displayed at the bottom of the MERCI window, provides the 
pathway and name of the database that is open and the current date. As with 
the toolbar, you can display or hide the status bar by doing one of the 
following: 
 

To Do this 

Display the status bar From the View menu, choose Status Bar 

Hide the status bar From the View menu, choose " Status Bar 

 



10 Ch. 2 – Getting Started MERCI User’s Guide (Draft) 

Revision date: June 25, 1999 

2.3.3 Open Database 
The first step in operating MERCI is to open up the database. There are two 
ways to open a database and a shortcut from the File menu. 

To open a database: 

1. From the File menu, choose Open Database, or click on the 

 button. 

2. Select the database and click on Open. 
 

Tip: MERCI provides a most recently used database file list under 
the File menu as a shortcut to opening the database. 

 

2.3.4 Exiting MERCI 

To exit from MERCI: 

• From the File menu, choose Exit; or 

• Click on the  button. 
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CHAPTER 3 

General Features 

This chapter provides information on the general features of the creel survey 
under the EDIT - GENERAL menu. The features of the survey over which the 
user has limited to full control includes: 
 

• Management Units 
• 24 Hour Access Sites 
• Gear Types 
• Observation Modes 
• Observation Methods 
• Harvesters 
• Native Bands 
• Permit Numbers 
• Observers 
• Observation Conditions 
• Passwords 

 
Note: when modifying these elements, it is important to keep in mind the 
legacy of the survey program so that the MERCI system remains compatible 
with previous years data. 

3.1 Management Units 
A Management Unit is a pre-defined area of the Fraser River used to stratify 
the collection of catch and effort data. These strata typically correspond with 
the traditional fishing areas of the different Native communities and with 
river morphology (e.g., demarcated by more significant tributaries 
confluencing with the Fraser River). As of the release of version 2.0 of the 
model, there were the following 18 Management units in use on the Fraser 
River between 1996 and 1998: 
 

1. C-L1 – Port Mann Bridge to Mission 

2. C-L2 – Mission to Harrison 
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3. C-L3 – Harrison to Hope 

4. C-L4 – Hope to Sawmill Creek 

5. D-01 – Sawmill Creek to Hell’s Gate 

6. D-02 – Hell’s Gate to Sam Adams 

7. D-03 – Sam Adams to Siwash Creek 

8. D-04 – Siwash Creek to Piglog Creek 

9. D-05 – Piglog Creek to Pooeyelth Creek 

10. D-06 – Pooeyelth Creek to Saw Creek (Skuppah) 

11. D-07 – Saw Creek to Stein River 

12. D-08 – Stein River to Texas Creek 

13. D-09 – Texas Creek to Lillooet (Old Bridge) 

14. D-10 – Thompson River to Bonaparte Confluence 

15. D-11 – Lillooet to Pavillion Creek 

16. D-12 – Pavillion Creek to Kelly Creek 

17. D-13 – Kelly Creek to Barney Creek 

18. D-14 – Barney Creek to Deadman Creek 
 
MERCI allows you to add, delete, update or replace Management Units. 
 

Warning! 

Care is required when deleting, updating, or replacing Man-
agement Units because this can lead to the loss of historical 
information or an inappropriate change in the meaning of the 
data (e.g., the misrepresentation of the data’s true spatial 
interpretation). 

 

To get to the EDIT MANAGEMENT UNIT dialog box: 

1. From the Edit Menu, choose General. 

2. Click on Management Units. 
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To add a new management unit: 

1. Go to the EDIT MANAGEMENT UNIT dialog box. The ADD 
RECORD TAB will appear. 

2. Type the name of the new unit in the existing Management Unit 
Name field. When adding a new Management Unit you must 
provide the first five characters in either of the following 
formats: D-??: or C-L?:, where ? can be either a letter or a 
number. 

3. Type in a description in the Description field (optional) 

4. Click on the Add Record button. To cancel adding the new 
Management Unit, click on the Cancel button. 

 
The DELETE, UPDATE and REPLACE tabs are disabled here. To perform any 
of these functions, you must have a “current” management unit selected from 
one of the data entry forms. Specifically, DELETE, UPDATE and REPLACE are 
accessible from the MU GEAR COUNTS or CATCH INTERVIEWS data entry 
forms described in Sections 4.2 and 4.3, respectively. 
 

Warning! 

Replacing and Updating may change the meaning of pre-
existing data. Use Update to change names (e.g., correct 
spelling errors). Replace should be used only to correct a data 
entry error in the current season’s database file. Use caution. 
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3.2 24-hour Access Sites 
24 Hour Access Sites are locations along the Fraser River where survey 
agents monitor effort around the clock tracking the number of actively 
fishing gill and dip nets in small subsections of selected strata. Every hour on 
the hour catch monitors observe fishers setting and pulling nets to produce a 
“24-hour count” of the number of nets actively fishing in the pre-defined area 
surrounding the access site. This is requisite information for estimating total 
effort as the survey data permits an estimate of the proportion of nets fishing 
in the time period(s) during which instantaneous effort counts were made. 
 
MERCI allows you to add, delete, update or replace 24-hour Access Sites in 
any Management Unit. 

To get to the EDIT ACCESS SITE LOCATIONS dialog box: 

1. From the Edit Menu, choose General. 

2. Click on 24hr Access Sites. 
 

 
 
As you can see, the EDIT ACCESS SITE LOCATIONS dialog box looks similar 
to the EDIT MANAGEMENT UNIT dialog box. This design is carried out 
throughout the model to facilitate ease of use. 
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To add a new Access Site: 

1. Go to the EDIT ACCESS SITE LOCATIONS dialog box as described 
above. The ADD RECORD TAB will appear. 

2. Select the Management Unit from the pick list in the 
Management Unit Containing The New Access Site field. 

3. Type in the name of the new site in the New Access Site Name 
field. 

4. Type in a description in the Description field (optional). 

5. Click on the Add Record button. To cancel adding the new 
access site, click on the Cancel button. 

 
Note: As with the EDIT MANAGEMENT UNIT dialog box, the DELETE, 
UPDATE and REPLACE tabs are disabled. To perform any of these functions, 
you must have a current 24-hour Access Unit selected from within the 
24-HOUR EFFORT SURVEY data entry form described in Section 4.4. 

3.3 Gear Types 
Unfortunately, Editing of Gear Types is currently not supported in version 
2.0 of MERCI. This design decision was motivated by an interest in 
maintaining compatibility with the legacy database design (database design 
inherited from DFO during development of MERCI 1). The legacy database 
is non-normalised and without referential integrity. As well as having many 
other inefficiencies and design induced error susceptibilities, this legacy 
design had information on the gear type built into the actual field names in 
some key tables. This made it impossible to perform gear type additions, 
deletions, or updates without making MERCI v.2.0 unable to support legacy 
database information. 

3.4 Observation Modes 
MERCI comes with a list of modes of observation used for the 1996 through 
1998 seasons. Roving boat, roving foot and roving vehicle, and access site 
are all modes used to contact and interview fishers. Both helicopters and 
fixed wing aircraft are used to count nets throughout the study area. An 
observation mode titled “confounded” exists to support legacy data were it is 
not possible to determine whether catch interviews were conducted at 
stationary access sites or via a roving method of contact. 

• Access site – fishers come to the survey agent at a defined site at 
the end of their trips.  Best results are obtained when survey 
agents are present for the full duration of the fishery. This 
information is used to estimate Cpue. These or other access sites 
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are also used to produce 24-hour net counts used in estimating 
total effort. 

• Confounded – not possible to distinguish whether the catch 
interview was conducted at an access site or by a roving mode of 
contact. 

• Fixed Wing – fixed wing air craft flies over the fishery to obtain a 
relatively instantaneous net count. 

• Helicopter – helicopter overflights are conducted to obtain a 
relatively instantaneous net count. 

• Roving boat – boat patrols are conducted to obtain catch 
interview information for Cpue estimation, and to collect gear 
counts to supplement helicopter overflight data. Boat patrols are 
able to obtain catch data in areas that may have otherwise been 
missed by vehicle patrols. 

• Roving foot – conducted to obtain catch interview information for 
Cpue estimation. Scheduled to cover areas that patrol boat did not 
have access to. 

• Roving vehicle – conducted to obtain catch interview information 
for Cpue estimation. The distinction between roving foot and 
roving vehicle is sometimes arbitrary (i.e., drive to a site via 
vehicle, and then walk down to the river edge to conduct the 
interview). 

 
MERCI allows you to add, delete, update or replace Observation Modes. 

To get to the EDIT OBSERVATION MODE dialog box: 

1. From the Edit Menu, choose General. 

2. Click on Observation Modes. 
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To add a new Observation Mode: 

1. Go to the OBSERVATION MODE dialog box as described above. 
The ADD RECORD TAB will appear. 

2. Scroll through the existing Modes in the Existing Observation 
Mode Names field to ensure you aren’t creating a duplicate. 

3. Type in the name of the new Mode in the Observation Mode 
Name field. 

4. Type in a description in the Description field (optional). 

5. Click on the Add Record button. To cancel adding the new 
access site, click on the Cancel button. 

 
As with the other dialog boxes, the DELETE, UPDATE and REPLACE tabs are 
disabled. To perform any of these functions, you must have selected a current 
Observation Mode from the MU GEAR COUNTS or CATCH INTERVIEW data 
entry forms described in Sections 4.2 and 4.3. 

3.5 Observation Methods 
MERCI comes with two methods of observation of fishing activities: 
 

• Hail 
• Observed 
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The Hail method is used when the interviewer obtains the numbers of fish 
caught from the fisher. These data are not independently verified. The 
Observed method is used when an interviewer handles and counts the 
number of fish caught themselves. 
 
MERCI allows you to add, delete, update or replace an Observation Method. 

To get to the EDIT OBSERVATION METHOD dialog box: 

1. From the Edit Menu, choose General. 

2. Click on Observation Methods. 
 

 
 

To add a new Observation Method: 

1. Go to the EDIT OBSERVATION METHOD dialog box. The ADD 
RECORD TAB will appear. 

2. Scroll through the existing Methods in the Existing Observation 
Method Names field to ensure you aren’t creating a duplicate. 

3. Type in the name of the new Method in the Observation Method 
Name field. 

4. Type in a description in the Description field (optional). 

5. Click on the Add Record button. To cancel adding the new 
access site, click on the Cancel button. 
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Note: As with the other dialog boxes, the DELETE, UPDATE and REPLACE 
tabs are disabled. To perform any of these functions, you must have a current 
Observation Method selected from the CATCH INTERVIEW data entry form 
described in Section 4.3. 

3.6 Harvesters 
MERCI provides a list of harvester names that have been carried over from 
the previous non-normalised version of the MERCI database. The 
MERCI v.1+ data entry system required users to manually type in the name 
of harvesters. This led to a wide range of variations in names for the same 
individuals (e.g., different numbers of spaces, variations in capitalisation, 
abbreviations, etc.). A more user friendly data entry system has been 
provided in version 2.0 that allows you to add, delete, update and/or replace 
new names to the system as time goes on. 

To get to the EDIT HARVESTER dialog box: 

1. From the Edit Menu, choose General. 

2. Click on Harvesters. 
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To add a new Harvester: 

1. Go to the EDIT HARVESTER dialog box. The ADD RECORD TAB 
will appear. 

2. Scroll through the existing Names in the Existing Harvester 
Names field to ensure you aren’t creating a duplicate. 
- Tip: If the list of fishers is long. To quickly find a name – click 

once in the Existing Harvester Names field, type the first letter 
of the person’s first name. 

3. Type in the name of the new Harvester in the Harvester Name 
field. 

4. Type in a description in the Description field (optional). 

5. Click on the Add Record button. Note: To cancel adding the 
new access site, click on the Cancel button. 

 
Note: As with the other dialog boxes, the DELETE, UPDATE and REPLACE 
tabs are disabled. To perform any of these functions, you must have a current 
Harvester selected from the CATCH INTERVIEW data entry form described in 
Chapter 4.3. 

3.7 Native Bands 
MERCI provides a list of existing Native band names that have been carried 
over from the 1996 to 1998 survey seasons. You may need to add, delete, 
update and/or replace the names in the system. 

To get to the EDIT NATIVE BAND dialog box: 

1. From the Edit Menu, choose General. 

2. Click on Native Bands. 
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To add a new Native Band Name: 

1. Go to the EDIT NATIVE BAND dialog box. The ADD RECORD 
TAB will appear. 

2. Scroll through the existing Names in the Existing Native Band 
Names field to ensure you aren’t creating a duplicate. 
- Tip: As with fishers – to quickly find a name – click in the 

field and type in the first letter of the band name. 
3. Type in the name of the new Band in the Native Band Name 

field. 

4. Type in a description in the Description field (optional). 

5. Click on the Add Record button. Note: To cancel adding the 
new access site, click on the Cancel button. 

 
Note: As with the other dialog boxes, the DELETE, UPDATE and REPLACE 
tabs are disabled. To perform any of these functions, you must have a current 
Native Band selected from the CATCH INTERVIEWS data entry form described 
in Section 4.3. 

3.8 Permit Numbers 
MERCI provides a list of permit numbers that have been carried over from 
the 1996 to 1998 survey seasons. You may need to add, delete, update or 
replace permit numbers in the system. 
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To get to the EDIT PERMIT NUMBER dialog box: 

1. From the Edit Menu, choose General. 

2. Click on Permit Numbers. 
 

 
 

To add a new Permit Number: 

1. Go to the EDIT PERMIT NUMBER dialog box. The ADD RECORD 
TAB will appear. 

2. Scroll through the existing Numbers in the Existing Permit 
Number Names field to ensure you aren’t creating a duplicate. 

3. Type in the Number of the new Permit in the Permit Number 
Name field. 

4. Type in a description in the Description field (optional). 

5. Click on the Add Record button. Note: To cancel adding the 
new access site, click on the Cancel button. 

 
Note: As with the other dialog boxes, the DELETE, UPDATE and REPLACE 
tabs are disabled. To perform any of these functions, you must have a current 
Permit number selected from the CATCH INTERVIEW data entry form 
described in Section 4.3. 
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3.9 Observers 
As with Harvesters, MERCI provides a list of Observers names that have 
been carried over from the 1996 to 1998 survey seasons. You may need to 
add, delete, update and replace names to the system as time goes on. 

To get to the EDIT OBSERVER dialog box: 

1. From the Edit Menu, choose General. 

2. Click on Observers. 
 

 
 

To add a new Observer: 

1. Go to the EDIT OBSERVER dialog box. The ADD RECORD TAB 
will appear. 

2. Scroll through the existing Names in the Existing Observer 
Names field to ensure you aren’t creating a duplicate. 

3. Type in the name of the new Observer in the Observer Name 
field. 

4. Type in a description in the Description field (optional). 

5. Click on the Add Record button. Note: To cancel adding the 
new access site, click on the Cancel button. 
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Note: As with the other dialog boxes, the DELETE, UPDATE and REPLACE 
tabs are disabled. To perform any of these functions, you must have selected 
a current Observer from within the MU GEAR COUNT, CATCH INTERVIEWS 
or 24-HOUR EFFORT PROFILES data entry forms described in Sections 4.3 and 
4.4. 

3.10 Observation Conditions 
MERCI provides a list of Observation Conditions that have been defined for 
use during the 1998 survey season. 
 
MERCI allows you to add, delete, update or replace Observation Conditions. 

To get to the EDIT OBSERVATION CONDITION dialog box: 

1. From the Edit Menu, choose General. 

2. Click on Observation Condition. 
 

 
 

To add a new Observation Condition: 

1. Go to the EDIT OBSERVATION CONDITION dialog box. The ADD 
RECORD TAB will appear. 

2. Scroll through the existing Names in the Existing Observation 
Conditions field to ensure you aren’t creating a duplicate. 

3. Type in the name of the new Condition in the Observation 
Condition Name field. 
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4. Type in a description in the Description field (optional). 

5. Click on the Add Record button. Note: To cancel adding the 
new observation condition, click on the Cancel button. 

 
Note: As with the other dialog boxes, the DELETE, UPDATE and REPLACE 
tabs are disabled. To perform any of these functions, you must have selected 
a current Observation Condition from the MU GEAR COUNTS or 24-HOUR 
EFFORT SURVEYS data entry forms described in Sections 4.2 and 4.4. 

3.11 Passwords 
Certain features in MERCI, such as editing Registered Users and deleting or 
updating database records, require a password to prevent the accidental 
modification or deleting of data. MERCI allows the user to change this 
password. 

To change the password: 

1. From the Edit Menu, choose General. 

2. Click on Password to get to the PASSWORD MAINTENANCE 
dialog box. 

 

 
1. Type your current password in the Current Password field. 

2. Type your new password in the New Password field. 

3. Re-type your new password in the Re-type New Password field. 

4. Click on the OK button. 
 

Warning! 

Do not forget this password. Write it down in a secure place. 
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CHAPTER 4 

Data Entry 

This chapter provides information on the survey data entry features found 
under the EDIT – DATA ENTRY menu. There are four data entry forms in 
MERCI that allow you to enter in the information obtained from the various 
surveys conducted. This chapter includes the following topics: 
 

• Fishery Openings 
• Gear Counts 
• Catch Interviews 
• 24-hour Effort Surveys 

4.1 Fishery Openings 
The FRASER RIVER FISHERY OPENINGS dialog box provides a form for the 
entry of information on the number of days that a specific fishery was legally 
open. If fishing occurred within the week outside of legal open times, then 
the number of days that the fishery was ‘fished’ should be supplied instead. 
You can add a new record to the database, view existing records, delete a 
record or update a record. 

To open the FRASER RIVER FISHERY OPENINGS dialog box: 

1. From the Edit Menu, choose Data Entry. 

2. Click on Fishery Openings. 
Or: 

1. From the MERCI window, hold down the Ctrl key and press the 
F key. This brings you directly to the dialog box. 

 
There are two different views to this dialog box; the ADD NEW MODE view 
and the VIEW AND MODIFY MODE view. The ADD NEW MODE is the default 
view and discussed in Section 4.1.1 while the VIEW AND MODIFY MODE will 
be discussed in Section 4.1.2. 
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To switch between the different views of the dialog box: 

1. Select Add New or View or Modify Existing from the Edit 
Menu. 

 

4.1.1 Fraser River Fishery Openings: Add New 
Mode 
The FRASER RIVER FISHERY OPENINGS: ADD NEW MODE dialog box 
requires you to enter information on the following: 
 

• Calendar year of the fishing season; 
• The week of the year; 
• The gear type (gill net, dip net or rod and reel); 
• The Management Unit; and 
• The length of time (in days) that fishing occurred in that week. 
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To complete the ADD NEW MODE dialog box: 

1. Click in the Fishing season field and type in the year (the current 
year is the default). 

2. Pick the week number from the dropdown list by clicking on the 
 button (the default is the current week). 

- If you do not know the number of the week, click on the  
button to bring up the MANAGEMENT WEEK FINDER dialog 
box. 

 

 
This dialog box will provide you with the week number of the 
fishing period of interest. To get the week number: 
- Select the month and year of the fishing period from drop 

down list. 
- Click on the day of the month if the fishing period is one day, 

or the first day of the month or week of interest. Please ensure 
that the day button is depressed as in the above figure. 

The week number appears in the Management Week field. 
- Click on the OK button. Note: To cancel adding the week 

number, click on the Cancel button. 
The week number now appears in the Week field of the ADD 
NEW MODE dialog box. 

3. Select the gear type by clicking on the appropriate option in the 
Regulations list. 
- Note: If choosing more than one, hold the Shift or Ctrl key 

and click on the appropriate Regulation to select or deselect. 
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4. Select the Management Unit(s) by clicking on the appropriate 
one in the Management Unit field to select or deselect. 
- Note: If choosing more than one, hold the Shift or Ctrl key 

and click on the appropriate Units. 
5. In the Days open field, select the number of days open by either: 

- scrolling through the numbers by clicking on the arrow 
buttons; or 

- clicking in the field and typing in the number of days. 
- Note: For obvious reasons, the maximum number of days 

allowed per week is seven. Remember you are entering the 
information for a given week of the year. If the fishing period 
carries over to the next week you must enter two records. 

6. Click on the Add button. 
 
You have now added a new record to the database. You can stay in this 
dialog box and enter in as many new records as you need. When you are 
done adding new records you have three options: 
 

To Do this 

View, delete, or update an 
existing record 

Go to the VIEW AND MODIFY MODE dialog 
box (Section 4.1.2) 

Explore the database Go to the CATCH AND EFFORT EXPLORER 
(See Section 8.1) 

Exit Click on the Close button 

 
 

4.1.2 Fraser River Fishery Openings: View and 
Modify Mode 
The FRASER RIVER FISHERY OPENINGS: VIEW AND MODIFY MODE dialog 
box allows you to search for a record to view, delete or update it. MERCI 
only allows you to update the number of days of the fishery opening. When 
searching for the number of days a fishery was open, all supporting fields 
must be supplied before executing the search. 
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To locate an existing Fraser River Fishery Opening record: 

1. Enter the required information by following steps 1 through 5 in 
Section 4.1.1. 

2. Click on the  button on the toolbar to search through the 
records. 

 
If there are existing records, MERCI will indicate this by changing the colour 
of the Days open field from grey to blue. If there are no records, a message 
will appear indicating that there are no records. You now have two options: 
 

To Do this 

Add the record you are 
looking for 

Click Yes to go to the ADD NEW MODE 
dialog box 

Resume your search Click No to return to the VIEW AND 
MODIFY MODE dialog box 

 



32 Ch. 4 – Data Entry MERCI User’s Guide (Draft) 

Revision date: June 25, 1999 

You can also use the CATCH AND EFFORT EXPLORER to easily find a record 
in the database when working with a fresh data entry template for a new 
survey season. You can then jump back to this dialog box to modify or delete 
the data. See Section 8.1 for further information. 
 

To Delete an existing Fraser River Fishery Opening record: 

1. Locate an existing record as described in steps 1 to 2 above. 

2. Click on the Delete button. 

3. Type in your password. 

4. Press Enter on your keyboard or click on the OK button. Note: 
To cancel deleting the record, click on the Cancel button. 

 

Warning! 

You will not be asked to confirm this deletion. 

 

To Update an existing Fraser River Fishery Opening record: 

1. Locate an existing record as described in steps 1 to 2 above. 

2. In the Days open field, change the number of days open by 
either: 
- scrolling through the numbers by clicking on the arrow 

buttons; or 
- clicking in the field and typing in the number of days. 
- Remember: The maximum number of days allowed is seven. 

3. Click on the Update button. 

4. Type in your password. 

5. Press Enter on your keyboard or click on the OK button. Note: 
To cancel deleting the record, click on the Cancel button. 

 

Warning! 

You will not be asked to confirm the replace. 

 
When you are done viewing or editing records you have three options: 
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To Do this 

Add a new record Go to the ADD NEW MODE dialog box (Section 
4.1.1) 

Explore the database Go to the CATCH AND EFFORT EXPLORER (See 
Section 8.1) 

Exit Click on the Close button; or click on the  
button. 

4.2 Gear Counts 
The MU GEAR COUNTS dialog box provides a form for the entry of 
information on instantaneous counts of fishing effort within each 
Management Unit. As with the Fishery Openings, you can add a new record 
to the database, view existing records, delete a record or update a record. 

To open the MU GEAR COUNTS dialog box: 

1. From the Edit Menu, choose Data Entry. 

2. Click on Gear Counts. 
Or: 

1. From the MERCI window, hold down the Ctrl key and press the 
G key. This brings you directly to the dialog box. 

 
There are two different views to this dialog box; the ADD NEW MODE view 
and the EDIT/DELETE EXISTING MODE view. The ADD NEW MODE is the 
default view and discussed in Section 4.2.1 while the EDIT/DELETE EXISTING 
MODE will be discussed in Section 4.2.2. 

To switch between the different views of the dialog box: 

1. Select Add New or Edit or Delete Existing from the Edit 
Menu. 

4.2.1 MU Gear Counts: Add New Mode 
The MU GEAR COUNTS: ADD NEW MODE dialog box requires you to enter 
information on the following: 
 

• Date of the survey 
• The time the survey enters each Management Unit 
• The gear counts (gill net, dip net or reels) 
• The Observation Mode 
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• The Observation Conditions 
• The Observers 
• Field notes. 

 
It also allows you to add new, or delete, update and replace existing 
Management Units, Observation Modes, and Observation Conditions. This is 
discussed in more detail in Section 4.2.3. 
 
The MU GEAR COUNTS: ADD NEW MODE dialog box is broken up into four 
boxes illustrated below: 
 

• Survey date; 
• Location / times; 
• Total gear counts; and 
• General. 

 

 
 

To complete the ADD NEW MODE dialog box: 

1. In the SURVEY DATE box, select the month and year of the 
interview from drop down lists and click on the day of the month 
of the survey. Please ensure that the day button is depressed as in 
the above figure. 

2. In the LOCATION / TIMES box, select the appropriate 
Management Unit by clicking on the  button and then 
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clicking on the Management Unit. The  button takes you to 
the EDIT MANAGEMENT UNITS dialog box where you can delete, 
update or replace MUs. This is described in more detail in 
Section 4.2.3. 

3. In the LOCATION / TIMES box, type in the time in 24-hour format 
(hh:mm) for the Time the survey entered the MU, the Entire 
survey start time (i.e., the time when the aircraft lifted off) and 
The entire survey end time (i.e., the time when the aircraft 
touched down) fields. 

4. In the TOTAL GEAR COUNTS box, select the number of each of 
the four gear types listed by: 
- scrolling through the numbers by clicking on the arrow 

buttons; or 
- clicking in the field and typing in the number. 

5. In the GENERAL box, select the Observation mode used by 
clicking on  button in the Observation mode field and clicking 
on the mode used. The  button takes you to the EDIT 
OBSERVATION MODE dialog box where you can delete, update or 
replace observation modes. How to do this is described in 
Section 4.2.3. 

6. In the GENERAL box, select the Observation conditions used by 
clicking on  button in the Observation condition field and 
clicking on the appropriate condition. The  button takes you 
to the EDIT OBSERVATION CONDITIONS dialog box where you 
can delete, update or replace observation conditions. How to do 
this is described in Section 4.2.3. 

7. In the GENERAL box, select the Observers by clicking on  
button in the Observers field. 

To  Do this 

Add an 
Observer 
Name 

Click on the Observer in the All Observer 
Names list on the left and click on the Add 
button or double-click on the Observer name 

Remove an 
Observer 
Name 

Click on the Observer Selected Observers list on 
the right and click on the Remove button or 
double-click on the Observer name 

The  button takes you to the EDIT OBSERVER dialog box, 
where you can delete, update or replace observation methods. 
This is described in more detail in Section 4.2.3. 
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8. In the GENERAL box, type any notes, directly into the Notes field 
(optional). 

9. Click on the Add button. Note: To cancel adding the survey 
record, click on the Close button. 

10. A confirmation message will appear. To continue adding the 
record, click on the Yes button, to cancel, click on the No button. 

 
You have now added a new record to the database. You can stay in this 
dialog box and enter in as many new records as you need. When you are 
done adding new records you have three options: 
 

To Do this 

View, delete, or update an 
existing record 

Go to the EDIT/DELETE dialog box (Section 
4.2.2) 

Explore the database Go to the CATCH AND EFFORT EXPLORER 
(See Section 8.1) 

Exit Click on the Close button 

 

4.2.2 MU Gear Counts: Edit/Delete Existing Mode 
The MU GEAR COUNTS: EDIT/DELETE EXISTING MODE dialog box allows 
you to search for a record to view it, delete it or update it. MERCI allows you 
to modify all fields for the existing record. The following is the minimum 
information required to perform a search: 
 

• Survey date; and 
• Time survey entered the MU. 
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To locate an existing MU Gear Count record: 

1. Enter the required information above by following steps 1 
through 2 in Section 4.2.1. 

2. In the LOCATION / TIMES box, type in the time in 24-hour format 
(hh:mm) for the Time the survey entered the MU. You do not 
need to enter the Entire survey start or end time. 

3. Click on the  button on the toolbar to search through the 
records. 

 
If there is an existing record, MERCI will indicate this by updating or filling 
in the information in the fields. If there are no records, a message will appear 
indicating that there are no records. You now have two options: 
 

To Do this 

Add the record you are 
looking for 

Click Yes to go to the ADD NEW MODE 
dialog box 

Resume your search Click No to return to the EDIT/DELETE 
EXISTING MODE dialog box 

 
You can also use the CATCH AND EFFORT EXPLORER to easily find a record 
in the database. You can then jump back to this dialog box to modify or 
delete the data. For further information, please see Section 8.1. 
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To Delete an existing MU Gear Count record: 

1. Locate an existing record as described in steps 1 to 3 above. 

2. Click on the Delete button. 

3. A confirmation message will appear. To delete the record, click 
on the Yes button, to cancel and preserve the record, click on 
the No button. 

To Update an existing MU Gear Count record: 

1. Locate an existing record as described in steps 1 to 3 above. 

2. As appropriate, make changes to any of the fields. 

3. Click on the Update button. 

4. A confirmation message will appear. To continue updating the 
record, click on the Yes button, to cancel, click on the No button. 

When you are done viewing or editing records you have three options: 
 

To Do this 

Add a new record Go to the ADD NEW MODE dialog box (Section 4.2.1) 

Explore the 
database 

Go to the CATCH AND EFFORT EXPLORER (See Section 
8.1) 

Exit Click on the Close button; or click on the  button. 

 

4.2.3 MU Gear Counts: Editing General Features 
There are four general features that you are able to edit from the MU GEAR 
COUNTS dialog box: 
 

• Management Units 
• Observation Modes 
• Observation Conditions 
• Observers 

Delete, Update or Replace Management Units 

MERCI allows the user to delete, update or replace existing Management 
Units from the MU GEAR COUNTS dialog box. You can also access this 
function from the INTERVIEW LOCATION/DATE AND REPORTED FISHING 
DURATION tab of the CATCH INTERVIEWS: ADD NEW MODE dialog box. 
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To get to the EDIT MANAGEMENT UNITS dialog box: 

1. Open the MU GEAR COUNTS dialog box as described at the 
beginning of Section 4.2. 

2. Select the Management Unit you want to edit by clicking on 
the  button and then clicking on the Management Unit. 

3. Click on the  button next to the Management Unit (MU) 
field to bring up the EDIT MANAGEMENT UNITS dialog box. The 
Add Record tab is the default. 

To Delete a Management Unit: 

1. Click on the Delete tab. The name of the Management Unit you 
want to delete will appear greyed out. 

2. Click on the Delete button. 

3. Type in your password. 

4. Press Enter on your keyboard or click on the OK button. Note: 
To cancel deleting the Management Unit, click on the Cancel 
button. 

Warning! 

If there are any Effort Profile, Catch Survey or Gear Count 
records for this Management Unit in the database they will 
also be deleted!  

 
5. If you are sure you want to delete the MU and all associated 

information, Click on the Yes button. If you aren’t sure, click 
on the No button. 

To Update a Management Unit’s Name or Description: 

1. Click on the Update tab. The name of the Management Unit 
you want to update will appear greyed out. 

2. Type in the new name for the MU in the Enter the new name for 
the Management Unit field. 

3. Type in the new description for the MU in the Management 
Unit Description field if applicable. 

4. Click on the Update button. 

5. Type in your password. 

6. Press Enter on your keyboard or click on the OK button. Note: 
To cancel updating the Management Unit, click on the Cancel 
button. 
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Warning! 

If the new Management Unit name changes the physical 
interpretation of the river section from which the data were 
collected, this operation should not be performed. 

 
7. If you are sure you want to replace name and description of the 

MU, Click on the Yes button. If you aren’t sure, click on the No 
button. 

To replace one MU with another: 

1. Click on the Replace tab. The name of the Management Unit 
you want to update will appear greyed out. 

2. Select the Management Unit you want to replace your current 
one by clicking on the  button and then clicking on the 
Management Unit. 

3. Click on the Replace button. 

4. Type in your password. 

5. Press Enter on your keyboard or click on the OK button. Note: 
To cancel deleting the Management Unit, click on the Cancel 
button. 

6. If you are sure you want to replace name and description of the 
MU, Click on the Yes button. If you aren’t sure, click on the No 
button. 

Delete, Update or Replace Observation Modes 

MERCI allows the user to delete, update or replace existing Observation 
Modes from the MU GEAR COUNTS dialog box. You can also access this 
function from the general tab of the CATCH INTERVIEWS: ADD NEW MODE 
dialog box. 
 

To get to the EDIT OBSERVATION MODE dialog box: 

1. Open the MU GEAR COUNTS dialog box as described at the 
beginning of Section 4.2. 

2. Select the Observation Mode you want to edit by clicking on 
the  button and then clicking on the Observation Mode; 

3. Click on the  button next to the Observation Mode field to 
bring up the EDIT OBSERVATION MODE dialog box. The Add 
Record tab is the default. 
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To Delete an Observation Mode: 

1. Click on the Delete tab. The name of the Observation Mode you 
want to delete will appear greyed out. 

2. Click on the Delete button. 

3. Type in your password. 

4. Press Enter on your keyboard or click on the OK button. Note: 
To cancel deleting the Observation Mode, click on the Cancel 
button. 

Warning! 

If there are any Effort Profile, Catch Survey or Gear Count 
records tagged with this Observation Mode they will all be 
deleted! 

 
5. If you are sure you want to delete the Observation Mode, Click 

on the Yes button. If you aren’t sure, click on the No button. 

To Update a Observation Mode Name or Description: 

1. Click on the Update tab. The name of the Observation Mode 
you want to update will appear greyed out. 

2. Type in the new name in the New Observation Mode Name 
field. 

3. Type in the new description in the Description field if 
applicable. 

4. Click on the Update button. 

5. Type in your password. 

6. Press Enter on your keyboard or click on the OK button. Note: 
To cancel updating the Observation Mode, click on the Cancel 
button. 

7. If you are sure you want to replace name and description of the 
Observation Mode, click on the Yes button. If you aren’t sure, 
click on the No button. 

To Replace one Observation Mode with another: 

1. Click on the Replace tab. The name of the Observation Mode 
you want to update will appear greyed out. 

2. Select the Observation Mode you want to replace your current 
one by clicking on the  button and then clicking on the 
Observation Mode in the With Observation Mode Name field. 

3. Click on the Replace button. 
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4. Type in your password. 

5. Press Enter on your keyboard or click on the OK button. Note: 
To cancel deleting the Observation Mode, click on the Cancel 
button. 

6. If you are sure you want to replace name and description of the 
Observation Mode, Click on the Yes button. If you aren’t sure, 
click on the No button. 

Delete, Update or Replace Observation Conditions 

MERCI allows the user to delete, update or replace existing Observation 
Conditions from the MU GEAR COUNTS dialog box. You can also access this 
function from the 24-HOUR EFFORT PROFILES dialog box. 

To get to the EDIT OBSERVATION CONDITIONS dialog box: 

1. Open the MU GEAR COUNTS dialog box as described at the 
beginning of Section 4.2. 

2. Select the Observation Condition you want to edit by clicking 
on the  button and then clicking on the Observation 
Condition. 

3. Click on the  button next to the Observation conditions field 
to bring up the EDIT OBSERVATION CONDITION dialog box. The 
Add Record tab is the default. 

To Delete an Observation Condition: 
 

Warning! 

If there are any Effort Profile, Catch Survey or Gear Count 
records tagged with this Observation Condition they will all 
be deleted! 

 
1. Click on the Delete tab. The name of the Observation Condition 

you want to delete will appear greyed out. 

2. Click on the Delete button. 

3. Type in your password. 

4. Press Enter on your keyboard or click on the OK button. Note: 
To cancel deleting the Observation Condition, click on the 
Cancel button. 

5. If you are sure you want to delete the Observation Condition, 
Click on the Yes button. If you aren’t sure, click on the No 
button. 
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To Update a Observation Condition Name or Description: 

1. Click on the Update tab. The name of the Observation 
Condition you want to update will appear greyed out. 

2. Type in the new name in the New Observation Condition Name 
field. 

3. Type in the new description in the Description field if 
applicable. 

4. Click on the Update button. 

5. Type in your password. 

6. Press Enter on your keyboard or click on the OK button. Note: 
To cancel updating the Observation Condition, click on the 
Cancel button. 

7. If you are sure you want to replace name and description of the 
Observation Condition, click on the Yes button. If you aren’t 
sure, click on the No button. 

To Replace one Observation Condition with another: 

1. Click on the Replace tab. The name of the Observation 
Condition you want to update will appear greyed out. 

2. Select the Observation Condition you want to replace your 
current one by clicking on the  button and then clicking on 
the Observation Condition in the With Observation Conditions 
Name field. 

3. Click on the Replace button. 

4. Type in your password. 

5. Press Enter on your keyboard or click on the OK button. Note: 
To cancel deleting the Observation Mode, click on the Cancel 
button. 

6. If you are sure you want to replace name and description of the 
Observation Mode, Click on the Yes button. If you aren’t sure, 
click on the No button. 

 

Delete, Update or Replace Observers 

MERCI allows the user to delete, update or replace existing Observers from 
the MU GEAR COUNTS dialog box. You can also access this function from 
the GENERAL tab of the CATCH INTERVIEWS or the 24-HOUR EFFORT 
PROFILES dialog box. 
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To get to the EDIT OBSERVER dialog box: 

1. Open MU GEAR COUNTS dialog box as described at the 
beginning of Section 4.2. 

2. Open the EDIT OBSERVERS FOR THE CURRENT GEAR COUNT 

dialog box by clicking on the  button next to the Observers 
field. 

3. Select the Observer you want to edit by clicking on the 
Observer in the All Observer Names list on the left. 

4. Click on the  button to the bottom right of the Observer 
name list to bring up the EDIT OBSERVER dialog box. The Add 
Record tab is the default. 

To Delete an Observer: 

1. Click on the Delete tab. The name of the Observer you want to 
delete will appear greyed out. 

2. Click on the Delete button. 

3. Type in your password. 

4. Press Enter on your keyboard or click on the OK button. Note: 
To cancel deleting the Observer, click on the Cancel button. 

5. If you are sure you want to delete the Observer, Click on the 
Yes button. If you aren’t sure, click on the No button. 

To Update a Observer Name or Description: 

1. Click on the Update tab. The name of the Observer you want to 
update will appear greyed out. 

2. Type in the new name in the New Observer Name field. 

3. Type in the new description in the Description field if 
applicable. 

4. Click on the Update button. 

5. Type in your password. 

6. Press Enter on your keyboard or click on the OK button. Note: 
To cancel updating the Observer, click on the Cancel button. 

7. If you are sure you want to replace name and description of the 
Observer, click on the Yes button. If you aren’t sure, click on 
the No button. 
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To Replace one Observer with Another: 

1. Click on the Replace tab. The name of the Observeryou want to 
update will appear greyed out. 

2. Select the Observer you want to replace your current one by 
clicking on the  button and then clicking on the Observer in 
the With Observer Name field. 

3. Click on the Replace button. 

4. Type in your password. 

5. Press Enter on your keyboard or click on the OK button. Note: 
To cancel deleting the Harvester, click on the Cancel button. 

6. If you are sure you want to replace name and description of the 
Harvester, Click on the Yes button. If you aren’t sure, click on 
the No button. 

4.3 Catch Interviews 
The CATCH INTERVIEW dialog box provides a form for the entry of 
information from interviews with fishers on their catch and the length of time 
their net was fishing. This information is used to calculate the Catch Per Unit 
Effort (Cpue). You can add a new record to the database, view existing 
records, delete a record or update a record. 

To open the CATCH INTERVIEW dialog box: 

1. From the Edit Menu, choose Data Entry. 

2. Click on Catch Interviews. 
Or: 

1. From the MERCI window, hold down the Ctrl key and press the 
C key. This brings you directly to the dialog box. 

 
There are two different views to this dialog box; the ADD NEW MODE view 
and the EDIT/DELETE EXISTING MODE view. The ADD NEW MODE is the 
default view and discussed in Section 4.3.1 while the EDIT/DELETE EXISTING 
MODE will be discussed in Section 4.3.2. 

To switch between the different views of the dialog box: 

• Select Add New or Edit or Delete Existing from the Edit Menu. 
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4.3.1 Catch Interviews: Add New Mode 
The CATCH INTERVIEWS: ADD NEW MODE dialog box is split up into the 
following tabs: 
 

• Interview Location/Date and Reported Fishing Duration 
• Reported Catch 
• General 

 
Click on the tabs to access the different information components. 

Add New Interview Location/Date and Reported 
Fishing Duration 

This tab allows you to enter the Management Unit, the Date and Time of the 
Interview and the duration of the trip (or soak time). It also allows you to add 
a new Management Unit or delete, update or replace an existing MU. This is 
discussed in more detail in Section 4.2.3. 
 

 
 

To complete the Interview Location/Date and Reported Fishing 
Duration tab: 

1. Open the CATCH INTERVIEWS: ADD NEW MODE dialog box as 
directed at the beginning of Section 3.1. 

2. Click on the Interview Location/Date and Reported Fishing 
Duration tab. 

3. Select the appropriate Management Unit by clicking on the  
button and then clicking on the Management Unit. The  
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button takes you to the EDIT MANAGEMENT UNITS dialog box, 
where you can delete, update, or replace MUs. This is described 
in more detail in Section 4.2.3. 

4. Enter the date of the interview by clicking on the  button next 
to the Date of Interview field. This brings up the MANAGEMENT 
WEEK FINDER dialog box. 

 
- Select the month and year of the interview from drop down 

lists. 
- Click on the day of the month of the interview. Please ensure 

that the day button is depressed as in the above figure. 
- Click on the OK button. Note: To cancel adding the interview 

date, click on the Cancel button. 
5. Type in the time of the interview in 24-hour clock format 

(hh:mm) in the Time of interview field. 

6. Repeat steps 4 and 5 for the Date and Time that the fishing trip 
started and ended. 
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You are done completing this tab. You now have three choices. 
 

To Do this 

Finish completing the 
information 

Click on either the REPORTED CATCH tab or the 
GENERAL tab. For information on how to fill out 
these tabs, see below. 

Cancel adding the 
information 

Click on the Close button 

Add the record to the 
database 

Click on the Add button. 

 

Add New Reported Catch 

This tab is used to specify the type of fishing gear used, the number of nets 
fished by the fisher or party (if net specific information could not be 
obtained) and the number of fish caught. 
 

 
 

To complete the REPORTED CATCH tab: 

1. Open the CATCH INTERVIEWS: ADD NEW MODE dialog box as 
directed above. 

2. Click on the Reported Catch tab. 

3. Select the type of fishing gear used by clicking on  button in 
the Gear type field and clicking on the type of gear used. You 
can only choose one type of gear. 
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4. Choose the number of nets used by either: 
- clicking on the arrow buttons to scroll up and down the list of 

numbers; or 
- clicking in the number box and typing the number of nets 

directly. 
Note: This number will only be greater than 1 when net specific 
catch information could not be obtained. 

5. For each type of fish caught, click in the box next to the name of 
the fish. The field for entering the number of fish only appears 
for those species that you have selected. Enter the number of fish 
caught by either: 
- clicking on the arrow buttons to scroll up and down the list of 

numbers; or 
- clicking in the number box and typing the number of fish 

directly. 
Note: For Chinook, please specify the number of adult and jacks 
caught. Please also note if any adipose clips were observed by 
clicking in the Yes or No field. 

6. Click on the Add button. 
 
You are done completing this tab. You now have three choices. 
 

To Do this 

Finish completing 
the information 

Click on either the INTERVIEW LOCATION… tab or the 
GENERAL tab. For information on how to fill out the 
former tab, see above – the latter tab, see below. 

Cancel adding the 
information 

Click on the Close button 

Add the record to 
the database 

Click on the Add button. 

 

Add New General Features 

This tab allows the user to enter the mode of observation along with 
supporting information about the harvester, observers and weather 
conditions. It also allows you to add new, or delete, update and replace 
existing Observation Modes, Observation Methods, Observers, Harvesters, 
Band affiliations, and Permit Numbers. This is discussed in more detail in 
Section 4.3.3. 
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To complete the GENERAL tab: 

1. Open the CATCH INTERVIEWS: ADD NEW MODE dialog box as 
directed above. 

2. Click on the General tab. 

3. Select the Observation mode used by clicking on  button in 
the Observation mode field and clicking on the mode used. The 

 button takes you to the EDIT OBSERVATION MODES dialog 
box, where you can delete, update or replace observation modes. 
This is described in more detail in Section 4.2.3. 

4. Select the Observation method used by clicking on  button in 
the Observation method field and clicking on the method used. 
The  button takes you to the EDIT OBSERVATION METHOD 
dialog box, where you can delete, update or replace observation 
methods. This is described in more detail in Section 4.3.3. 

5. To select the Observers, click on  button in the Observers 
field. 

To  Do this 

Add an 
Observer Name 

Click on the Observer in the All Observer 
Names list on the left and click on the Add 
button or double-click on the Observer name 

Remove an 
Observer Name 

Click on the Observer Selected Observers list 
on the right and click on the Remove button 
or double-click on the Observer name 
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The  button takes you to the EDIT OBSERVER dialog box, 
where you can delete, update or replace observation methods. 
This is described in more detail in Section 4.2.3. 

6. To select the Harvesters, click on  button next to the 
Harvesters field. 

To  Do this 

Add an 
Harvester Name

Click on the Harvester in the All Harvester 
Names list on the left and click on the Add 
button or double-click on the Harvester name 

Remove an 
Harvester Name

Click on the Harvester Selected Harvester list 
on the right and click on the Remove button 
or double-click on the Harvester name 

The  button takes you to the EDIT HARVESTER dialog box, 
where you can delete, update or replace observation methods. 
This is described in more detail in Section 4.3.3. 

7. Select the Native Band by clicking on  button in the Band 
affiliation field and clicking on the Band name. The  button 
takes you to the NATIVE BAND dialog box, where you can delete, 
update or replace Native Bands. This is described in more detail 
in Section 4.3.3. 

8. Select the Permit Number by clicking on  button in the Permit 
number field and clicking on the number. The  button takes 
you to the PERMIT NUMBER dialog box, where you can delete, 
update or replace Permit numbers. This is described further in 
Section 4.3.3. 

9. Type any notes, directly into the Notes field (optional). 

10. Click on the OK button. Note: To cancel adding the record, click 
on the Cancel button. 

 
You are done completing this tab. You now have three choices. 
 

To Do this 

Finish completing the 
information 

Click on either the INTERVIEW LOCATION… tab or 
the REPORTED CATCH tab. For information on 
how to fill out these tabs, see above. 

Cancel adding the 
information 

Click on the Close button 

Add the record to the 
database 

Click on the Add button. 
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4.3.2 Catch Interviews: Edit/Delete Existing Mode 
The CATCH INTERVIEWS: EDIT/DELETE EXISTING MODE dialog box allows 
you to search for a record to view it, delete it or update it. Once a record has 
been identified, all of its fields can be updated. The following information is 
required to search for a catch interview record: 
 

• Management Unit; 
• Date and time of the Interview; 
• The date and time the fishing trip started; and, 
• The date and time the fishing trip ended. 

 

 

To locate an existing Catch Interview record: 

1. Open the CATCH INTERVIEWS: ADD NEW MODE dialog box as 
directed at the beginning of Section 3.1. 

2. Click on the Interview Location/Date and Reported Fishing 
Duration tab. 

3. Select the appropriate Management Unit by clicking on the  
button and then clicking on the Management Unit. 

4. Enter the date of the interview by clicking on the  button next 
to the Date of Interview field. This brings up the MANAGEMENT 
WEEK FINDER dialog box. 
- Select the month and year of the interview from drop down 

lists. 
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- Click on the day of the month of the interview. Please ensure 
that the day button is depressed as in the above figure. 

- Click on the OK button. Note: To cancel adding the interview 
date, click on the Cancel button. 

5. Type in the time of the interview in 24-hour clock format 
(hh:mm) in the Time of interview field. 

6. Repeat steps 4 and 5 for the Date and Time that the fishing trip 
started and ended. 

7. Click on the  button on the toolbar to search through the 
records. 

If there is an existing record, MERCI will indicate this by filling in the 
information in the blank fields. If there are no records, a message will appear 
indicating that there are no records. You now have two options: 
 

To Do this 

Add the record you 
are looking for 

Click Yes to go to the ADD NEW MODE dialog box 

Resume your search Click No to return to the EDIT/DELETE EXISTING 
MODE dialog box 

 
You can also use the CATCH AND EFFORT EXPLORER to easily find a record 
in the database. You can then jump back to this dialog box to modify or 
delete the data. For further information, please see Section 8.1. 
 

To Delete an existing Catch Interview record: 

1. Locate an existing record as described in steps 1 to 7 above. 

2. Click on the Delete button. 

3. A confirmation message will appear. To continue deleting the 
record, click on the Yes button, to cancel, click on the No button. 

To Update an existing Catch Interview record: 

1. Locate an existing record as described in steps 1 to 7 above. 

2. Make changes to the appropriate fields. 

3. Click on the Update button. 

4. A confirmation message will appear. To continue deleting the 
record, click on the Yes button, to cancel, click on the No button. 
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When you are done viewing or editing records you have three options: 
 

To Do this 

Add a new record Go to the ADD NEW MODE dialog box (Section 4.3.1) 

Explore the 
database 

Go to the CATCH AND EFFORT EXPLORER (See 
Section 8.1) 

Exit Click on the Close button; or click on the  button. 

 

4.3.3 Catch Interviews: Editing General Features 
There are six general features that you are able to edit from the GENERAL tab 
of the CATCH INTERVIEWS dialog box: 
 

• Observation Modes (see Section 4.2.3) 

• Observation Methods 

• Observers (see Section 4.2.3) 

• Harvesters 

• Band Affiliations 

• Permit Numbers 

Delete, Update or Replace Observation Methods 

MERCI allows the user to delete, update or replace existing Observation 
Methods from the GENERAL tab of the CATCH INTERVIEWS dialog box. You 
can also access this function from the INTERVIEW LOCATION/DATE AND 
REPORTED FISHING DURATION tab of the CATCH INTERVIEWS: ADD NEW 
MODE dialog box. 

To get to the EDIT OBSERVATION METHODS dialog box: 

1. Open the CATCH INTERVIEWS dialog box as described at the 
beginning of Section 4.3 and click on the GENERAL tab. 

2. Select the Observation Method you want to edit by clicking on 
the  button and then clicking on the Observation Method. 

3. Click on the  button next to the Observation Method field to 
bring up the EDIT OBSERVATION METHOD dialog box. The Add 
Record tab is the default. 
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To Delete an Observation Method: 

Warning! 

If there are any existing Catch Survey records tagged with 
this Observation Method they will all be deleted! 

 
1. Click on the Delete tab. The name of the Observation Method 

you want to delete will appear greyed out. 

2. Click on the Delete button. 

3. Type in your password. 

4. Press Enter on your keyboard or click on the OK button. Note: 
To cancel deleting the Observation Method (and associated 
records), click on the Cancel button. 

5. If you are sure you want to delete the Observation Method (and 
associated records), Click on the Yes button. If you aren’t sure, 
click on the No button. 

To Update a Observation Method Name or Description: 

1. Click on the Update tab. The name of the Observation Method 
you want to update will appear greyed out. 

2. Type in the new name in the New Observation Method Name 
field. 

3. Type in the new description in the Description field if 
applicable. 

4. Click on the Update button. 

5. Type in your password. 

6. Press Enter on your keyboard or click on the OK button. Note: 
To cancel updating the Observation Method, click on the Cancel 
button. 

7. If you are sure you want to replace name and description of the 
Observation Method, click on the Yes button. If you aren’t sure, 
click on the No button. 

To Replace one Observation Method with another: 

1. Click on the Replace tab. The name of the Observation Method 
you want to update will appear greyed out. 

2. Select the Observation Method you want to replace your 
current one by clicking on the  button and then clicking on the 
Observation Method in the With Observation Method Name 
field. 

3. Click on the Replace button. 
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4. Type in your password. 

5. Press Enter on your keyboard or click on the OK button. Note: 
To cancel deleting the Observation Method, click on the Cancel 
button. 

6. If you are sure you want to replace name and description of the 
Observation Method, Click on the Yes button. If you aren’t sure, 
click on the No button. 

Delete, Update or Replace Harvesters 

MERCI allows the user to delete, update or replace existing Harvesters from 
the GENERAL tab of the CATCH INTERVIEWS dialog box. You can also access 
this function from the INTERVIEW LOCATION/DATE AND REPORTED FISHING 
DURATION tab of the CATCH INTERVIEWS: ADD NEW MODE dialog box 

To get to the EDIT HARVESTER dialog box: 

1. Open the CATCH INTERVIEWS dialog box as described at the 
beginning of Section 4.3 and click on the GENERAL tab. 

2. Open the EDIT CATCH SURVEY HARVESTER NAMES dialog box 
by clicking on the  button next to the Harvesters field. 

3. Select the Harvester you want to edit by clicking on the 
Harvester in the All Harvester Names list on the left. 

4. Click on the  button to the bottom right of the Harvester name 
list to bring up the EDIT HARVESTER dialog box. The Add 
Record tab is the default. 

To Delete a Harvester: 

1. Click on the Delete tab. The name of the Harvester you want to 
delete will appear greyed out. 

2. Click on the Delete button. 

3. Type in your password. 

4. Press Enter on your keyboard or click on the OK button. Note: 
To cancel deleting the Harvester, click on the Cancel button. 

5. If you are sure you want to delete the Harvester, Click on the 
Yes button. If you aren’t sure, click on the No button. 

To Update a Harvester Name or Description: 

1. Click on the Update tab. The name of the Harvester you want to 
update will appear greyed out. 

2. Type in the new name in the New Harvester Name field. 

3. Type in the new description in the Description field if 
applicable. 
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4. Click on the Update button. 

5. Type in your password. 

6. Press Enter on your keyboard or click on the OK button. Note: 
To cancel updating the Harvester, click on the Cancel button. 

7. If you are sure you want to replace name and description of the 
Harvester, click on the Yes button. If you aren’t sure, click on 
the No button. 

To Replace one Harvester with another: 

1. Click on the Replace tab. The name of the Harvester you want to 
update will appear greyed out. 

2. Select the Harvester you want to replace your current one by 
clicking on the  button and then clicking on the Harvester in 
the With Harvester Name field. 

3. Click on the Replace button. 

4. Type in your password. 

5. Press Enter on your keyboard or click on the OK button. Note: 
To cancel deleting the Harvester, click on the Cancel button. 

6. If you are sure you want to replace name and description of the 
Harvester, Click on the Yes button. If you aren’t sure, click on 
the No button. 

Delete, Update or Replace Band Affiliations 

MERCI allows the user to delete, update or replace existing Band 
Affiliations from the GENERAL tab of the CATCH INTERVIEWS dialog box. 

To get to the EDIT NATIVE BAND dialog box: 

1. Open the CATCH INTERVIEWS dialog box as described at the 
beginning of Section 4.3 and click on the GENERAL tab. 

2. Select the Native Band you want to edit by clicking on the  
button next to the Band affiliation field and then clicking on the 
Native Band. 

3. Click on the  button next to the Band affiliation field to bring 
up the EDIT NATIVE BAND dialog box. The Add Record tab is the 
default. 

To Delete a Native Band: 

1. Click on the Delete tab. The name of the Native Band you want 
to delete will appear greyed out. 

2. Click on the Delete button. 
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3. Type in your password. 

4. Press Enter on your keyboard or click on the OK button. Note: 
To cancel deleting the Native Band, click on the Cancel button. 

 

Warning! 

If there are any existing Catch Survey records tagged with 
this Native Band they will also be deleted. 

 
5. If you are sure you want to delete the Native Band, Click on the 

Yes button. If you aren’t sure, click on the No button. 

To Update a Native Band Name or Description: 

1. Click on the Update tab. The name of the Native Band you want 
to update will appear greyed out. 

2. Type in the new name in the New Native Band Name field. 

3. Type in the new description in the Description field if 
applicable. 

4. Click on the Update button. 

5. Type in your password. 

6. Press Enter on your keyboard or click on the OK button. Note: 
To cancel updating the Native Band, click on the Cancel button. 

7. If you are sure you want to replace name and description of the 
Native Band, click on the Yes button. If you aren’t sure, click on 
the No button. 

To Replace one Native Band with another: 

1. Click on the Replace tab. The name of the Native Band you 
want to update will appear greyed out. 

2. Select the Native Band you want to replace your current one by 
clicking on the  button and then clicking on the Native Band 
in the With Native Band Name field. 

3. Click on the Replace button. 

4. Type in your password. 

5. Press Enter on your keyboard or click on the OK button. Note: 
To cancel deleting the Native Band, click on the Cancel button. 

6. If you are sure you want to replace name and description of the 
Native Band, click on the Yes button. If you aren’t sure, click on 
the No button. 
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Delete, Update or Replace Permit Numbers 

MERCI allows the user to delete, update or replace existing Permit Numbers 
from the GENERAL tab of the CATCH INTERVIEWS dialog box. 

To get to the EDIT PERMIT NUMBER dialog box: 

1. Open the CATCH INTERVIEWS dialog box as described at the 
beginning of Section 4.3 and click on the GENERAL tab. 

2. Select the Permit Numbers you want to edit by clicking on the 
 button and then clicking on the Permit Numbers. 

3. Click on the  button next to the Permit number field to bring 
up the EDIT PERMIT NUMBER dialog box. The Add Record tab is 
the default. 

 

To Delete a Permit Number: 

1. Click on the Delete tab. The name of the Permit Number you 
want to delete will appear greyed out. 

2. Click on the Delete button. 

3. Type in your password. 

4. Press Enter on your keyboard or click on the OK button. Note: 
To cancel deleting the Permit Number, click on the Cancel 
button. 

 

Warning! 

If there are any Catch Survey records with this Permit Number 
they will also be deleted. 

 

5. If you are sure you want to delete the Permit Number, Click on 
the Yes button. If you aren’t sure, click on the No button. 

To Update a Permit Number Name or Description: 

1. Click on the Update tab. The name of the Permit Number you 
want to update will appear greyed out. 

2. Type in the new name in the New Permit Number Name field. 

3. Type in the new description in the Description field if 
applicable. 

4. Click on the Update button. 

5. Type in your password. 
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6. Press Enter on your keyboard or click on the OK button. Note: 
To cancel updating the Permit Number, click on the Cancel 
button. 

7. If you are sure you want to replace name and description of the 
Permit Number, click on the Yes button. If you aren’t sure, click 
on the No button. 

To replace one Permit Number with another: 

1. Click on the Replace tab. The name of the Permit Number you 
want to update will appear greyed out. 

2. Select the Permit Number you want to replace your current one 
by clicking on the  button and then clicking on the Permit 
Number in the With Permit Number Name field. 

3. Click on the Replace button. 

4. Type in your password. 

5. Press Enter on your keyboard or click on the OK button. Note: 
To cancel deleting the Permit Number, click on the Cancel 
button. 

6. If you are sure you want to replace name and description of the 
Permit Number, Click on the Yes button. If you aren’t sure, click 
on the No button. 

4.4 24-hour Effort Surveys 
The 24-HOUR EFFORT SURVEYS dialog box provides a form for the entry of 
information on the 24-hour harvesting activity pattern for each gear type. 
Gear counts are done on the hour every hour over 24-hours for each shift. 
The survey information is used in conjunction with instantaneous gear counts 
to estimate effort. You can either add a new record to the database, view 
existing records, delete a record or update a record. 

To open the 24-HOUR EFFORT SURVEYS dialog box: 

1. From the Edit Menu, choose Data Entry. 

2. Click on 24-hour Effort Surveys. 
Or: 

1. From the MERCI window, hold down the Ctrl key and press the 
U key. This brings you directly to the dialog box. 

 
There are two different views to this dialog box; the ADD NEW MODE view 
and the EDIT/DELETE EXISTING MODE view. The ADD NEW MODE is the 
default view and discussed in Section 4.4.1 while the EDIT/DELETE EXISTING 
MODE will be discussed in Section 4.4.2. 
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To switch between the different views of the dialog box: 

• Select Add New or Edit or Delete Existing from the Edit Menu. 
 
 

4.4.1 24-hour Effort Surveys: Add New Mode 
The 24-HOUR EFFORT PROFILES: ADD NEW MODE dialog box requires you to 
enter information on the following: 
 

• The location 
• The date and time 
• Hourly gear counts 
• Weather conditions 
• Observers 
• Notes (optional) 

 
The dialog box is broken up into three sections: 
 

• The location and time 
• The hourly gear counts 
• General information 

 
The date, starting time block, and access site apply to all 24 hourly time 
block records. 
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To fill out the dialog box: 

1. Enter the date monitoring started by clicking on the  button 
next to the Date monitoring started field. This brings up the 
MANAGEMENT WEEK FINDER dialog box. 
- Select the month and year of the interview from drop down 

lists; 
- Click on the day of the month of the interview. Please ensure 

that the day button is depressed as in the above figure. 
- Click on the OK button. Note: To cancel adding the 24-hour 

effort survey date, click on the Cancel button. 

2. Select the appropriate Time block by clicking on the  button 
and then clicking on the Time block. This refers to the hour 
block in which the entire 24-hour effort survey started on the 
said date. 

3. Select the appropriate Access Site by clicking on the  button 
and then clicking on the name. The  button takes you to the 
ACCESS SITES dialog box, where you can delete, update or 
replace observation methods. This is described in more detail in 
Section 4.4.3. 

4. Select the number of Gill nets fishing by either: 
- clicking on the arrow buttons to scroll up and down the list of 

numbers; or 
- clicking in the number box and typing the number of nets 

directly. 
5. Repeat step 4 for the number of Dip nets active, the Reels 

Active and the Gill nets active. 

6. Click on the Next>> button to add the time block records to the 
list box to the right of the button. Note: these records are not 
added to the database until the Add button is clicked. The Add 
button is only enabled when 24 records are shown in the list 
box. 

7. Repeat steps 4 through 6 for each time block. 

8. Select the Weather conditions by clicking on the  button 
and then clicking on the weather condition. The  button 
takes you to the OBSERVATION CONDITIONS dialog box, where 
you can delete, update or replace observation methods. This is 
described in more detail in Section 4.2.3. 
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9. To select the Observers, click on  button in the Observers 
field. 

To  Do this 

Add an 
Observer Name 

Click on the Observer in the All Observer 
Names list on the left and click on the Add 
button or double-click on the Observer name 

Remove an 
Observer Name 

Click on the Observer Selected Observers list 
on the right and click on the Remove button 
or double-click on the Observer name 

The  button takes you to the EDIT OBSERVER dialog box, where 
you can delete, update or replace observation methods. This is 
described in more detail in Section 4.2.3. 
 
10. Type any notes directly into the Notes box (optional). 

 
You must enter in information for all 24 time blocks. The Add button will 
remain greyed out until you do so. 
 
To add the record, click on the Add button. Note: To cancel adding the 
records click on the Cancel button. 

 
You have now added a new record to the database. You can stay in this 
dialog box and enter in as many new records as you need. When you are 
done adding new records you have three options: 
 

To Do this 

View, delete, or update 
an existing record 

Go to the VIEW AND MODIFY MODE dialog box 
(Section 4.4.2) 

Explore the database Go to the CATCH AND EFFORT EXPLORER (See 
Section 8.1) 

Exit Click on the Close button 
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4.4.2 24-hour Effort Surveys: Edit/Delete Existing 
Mode 
The 24-HOUR EFFORT SURVEYS: EDIT/DELETE EXISTING MODE dialog box 
allows you to search for a record to view it, delete it or update it. The Date 
monitoring started, the Access Site name, and the starting time block are the 
minimum information required to perform a search. 
 

 
 

To locate an existing 24-hour Effort Surveys record: 

1. Select the Date monitoring started (you may have to toggle 
between ADD NEW and EDIT/DELETE EXISTING modes to change 
the date). 

2. Select the Time block survey started (you may have to toggle 
between ADD NEW and EDIT/DELETE EXISTING modes to change 
the starting time block). 

3. Select the appropriate Access Site by clicking on the  button 
and then clicking on the Access Site button. 

4. Click on the  on the toolbar to search through the existing 
records. 

 
If there is an existing record, MERCI will indicate this by filling in the 
information in the blank fields. If there are no records, a message will appear 
indicating that there are no records. You now have two options: 
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To Do this 

Add the record you 
are looking for 

Click Yes to go to the ADD NEW MODE dialog box 

Resume your 
search 

Click No to return to the EDIT/DELETE EXISTING 
MODE dialog box 

 
You can also use the CATCH AND EFFORT EXPLORER to easily find a record 
in the database. You can then jump back to this dialog box to modify or 
delete the data. For further information, please see Section 8.1. 
 

To Delete an existing 24-hour Effort Surveys record: 

1. Locate an existing record as described in steps 1 to 2 above. 

2. Click on the Delete button. 

3. A confirmation message will appear. To continue deleting the 
record, click on the Yes button, to cancel, click on the No button. 

To Update an existing 24-hour Effort Surveys record: 

1. Locate an existing record as described in steps 1 to 2 above. 

2. Make changes to the appropriate fields. 

3. Click on the Update button. 

4. A confirmation message will appear. To continue deleting the 
record, click on the Yes button, to cancel, click on the No button. 

 
When you are done viewing or editing records you have three options: 
 

To Do this 

Add a new record Go to the ADD NEW MODE dialog box (Section 4.4.1) 

Explore the 
database 

Go to the CATCH AND EFFORT EXPLORER (See Section 
8.8.1) 

Exit Click on the Close button; or click on the  button. 
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4.4.3 24-hour Catch Interviews: Editing General 
Features 
There are three general features that you are able to edit from the 24HR 
EFFORT PROFILES dialog box: 
 

• Access Sites 
• Observation Conditions (Section 4.2.3) 
• Observers (Section 4.2.3) 

Delete, Update or Replace Access Sites 

MERCI allows the user to delete or replace existing Access Sites from the 
24HR EFFORT PROFILES dialog box. 

To get to the Edit Access Site Locations dialog box: 

1. Open the 24HR EFFORT PROFILES dialog box as described at the 
beginning of Section 4.4. 

2. Select the Access Site you want to edit by clicking on the  
button next to the 24-hour access site management unit ID and 
name field and then clicking on the Access Site; 

3. Click on the  button next to the 24-hour access site 
management unit ID and name field to bring up the EDIT 
ACCESS SITE LOCATIONS dialog box. The Add Record tab is the 
default. 

To Delete an Access Site: 
 

Warning! 

If there are any 24-Hour Effort Survey records for this Access 
Site they will also all be deleted. 

 
1. Click on the Delete tab. The name of the Access Sites you want 

to delete will appear greyed out. 

2. Click on the Delete button. 

3. Type in your password. 

4. Press Enter on your keyboard or click on the OK button. Note: 
To cancel deleting the Access Sites, click on the Cancel button. 

5. If you are sure you want to delete the Access Sites, Click on the 
Yes button. If you aren’t sure, click on the No button. 
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To Replace one Access Site with another: 

1. Click on the Replace tab. The name of the Access Sites you 
want to update will appear greyed out. 

2. Select the Access Sites you want to replace your current one by 
clicking on the  button and then clicking on the Access Sites; 

3. Click on the Replace button. 

4. Type in your password. 

5. Press Enter on your keyboard or click on the OK button. Note: 
To cancel deleting the Access Sites, click on the Cancel button. 

6. If you are sure you want to replace name and description of the 
Access Sites, Click on the Yes button. If you aren’t sure, click on 
the No button. 
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CHAPTER 5 

Estimation 

MERCI was designed to provide weekly estimates of catch for each species, 
gear type, and management unit (MU). MERCI estimates catch as (subscripts 
pertaining to the gear type, species, MU, and week of interest are not 
indicated for ease of notation), 
 

EpueCfC ˆˆˆ ••=    [1] 

where, Ĉ was the catch estimate, f was the number of days a particular 

fishery was legally open in a given MU and week, pueĈ was the estimated 

average catch.(net hour)-1 for the fishery in that week, and Ê was the average 
total daily effort (net hours.day-1) in the fishery in that week. This equation 
provides an accurate estimate of catch so long as each component is 
estimated independently without bias. 
 

pueĈ  can be estimated using the ratio of means estimator, 
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where, iC  is the catch of the species of interest by the gear of interest 
reported during interview i, iL , is the trip length (the length of time the gear 
was fished to obtain iC ) and cn  is the number of interviews (obtained from 
particular modes of contact) done during the week of interest in the area of 
interest, for the gear of interest. An estimate of pueĈ  can also be obtained 
via the mean of ratios estimator, 
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where, iC  is the catch of the species of interest by the gear of interest 
reported during interview i, iL , is the trip length (the length of time the gear 
was fished to obtain iC ) and in  is the number of interviews (obtained from 
particular modes of contact) done during the week of interest in the area of 
interest, for the gear of interest. 
 

Ê  was estimated by, 
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where, iI  is the instantaneous count of actively fishing nets seen during 
overflight2 i, on  was the number of overflights made during the week of 

interest, and P  was the estimated proportion of nets fishing in the time 
period(s) during which the overflights occurred. Thus, P  approximates the 
probability of observing nets at different times of the day for a particular 
week and MU (e.g., if effort were constant over 24 hours, the probability of 
observing gear in a particular hour block would simply be 1/24 = 0.04167). 
P  was needed to inflate the instantaneous net counts to obtain the desired 
units of effort for estimating total catch – net hours.day-1. 
 
Knowing the time block(s) when the overflight counts were made, the 
24-hour effort surveys were used to estimate the proportion of nets fishing in 
the time period(s) during which the overflights occurred, P  as, 
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where, ijke  was the net count during the i-th time block in the j-th 24-hour 

effort survey at access point k, 
ipn was the number of 24-hour effort surveys 

done at access site i, an was the number of access sites used to construct the 
effort profile in the area of interest, ft was the set of hourly 24-hour survey 
times which occurred at the same time of day as that the overflights were 
conducted, and tn  was the size of the set ft . The numerator te was the sum 
of the average number of nets seen at each site during the time of day that the 
overflight counts were conducted (in units of nets). The denominator Te  was 
the sum of the average number of nets observed over 24-hours at all the 

                                                      
2 Other observation modes could be used. 
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access sites used (in units of net hours.day-1); (McDonald and McDonald 
19983). 

 
The Estimation chapter provides options for estimating each of the 
components in Equation 1. This chapter describes these options which are 
found under the EDIT – ESTIMATION menu. This chapter includes the 
following topics: 

 
• Users 
• Ibar Observation Mode Scenarios 
• Pbar Aggregation Scenarios 
• Cpue Estimator Definitions 
• Contact Method – Cpue Estimator Definitions 
• Cpue Aggregation Scenarios 
• Confidence Intervals 

 
The Ibar and Pbar Scenarios are control options that relate to catch effort 
estimation (Equations 4 and 5). The next three control options are related to 
Cpue estimation (Equations 2 and 3). 

5.1 Users 
All users who are running catch estimates must be a Registered User of 
MERCI. One of the properties of a catch estimation scenario is a user name. 
This allows the generator of the estimates to be tracked if there are any 
questions about the rationale for the scenario. You can create a new user, edit 
a user or delete a user. MERCI requests information on the user’s name, 
e-mail address, phone number and fax number. 

To open the MERCI USERS dialog box: 

1. From the Edit menu, choose Estimation. 

2. Click on Users. 

3. Type your password in the Password field. 

4. Click on the OK button. Note: To cancel, click on the Cancel 
button. 

                                                      
3 McDonald, T.L. and L.L. McDonald.  1998.  Review of sockeye catch estimation procedures on the Fraser River between 

Sawmill Creek and Kelly Creek.  WEST Technical Report No. 98-1, Dated May 20, 1998.  WEST Inc., 2003 Central 
Avenue, Cheyenne, Wyoming 82001. 
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To add a New User: 

1. Open the MERCI USERS dialog box as directed above. 

2. Click on the New button. The fields should now be blank. 

3. Type in the user name in the Registered users field. 

4. Type in the user e-mail in the e-mail id field. 

5. Type in the user’s primary phone number in the primary phone 
# field. Type in a secondary number in the secondary phone # 
field if applicable. 

6. Type in the User’s fax number in the fax # field. 

7. Click on the Apply button. Note: To cancel adding the user, 
click on the Cancel button. 

You have added a new user to the database. You can stay in this dialog box 
and enter in as many new users as you need. When you are done adding new 
user’s you have three options: 
 

To Do this 

Edit a User See below 

Delete a User See below 

Exit the MERCI USERS 
dialog box 

Click on the OK button 

 
 
MERCI allows you to edit any of the information for a user except the user’s 
name. 
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To edit a User: 

1. Open the MERCI USERS dialog box as directed above. 

2. Select the User you want to edit by clicking on the  button 
and then clicking on the User’s name. 

3. Click on the Edit button. 

4. Type in the information you want to change in the appropriate 
fields. 

5. Click on the Apply button. Note: To cancel editing the user, 
click on the Cancel button. 

 
You have edited a user in the database. You can stay in this dialog box and 
edit in as many users as you need. When you are done editing you have three 
options: 
 

To Do this 

Add a New User See above 

Delete a User See below 

Exit the MERCI USERS 
dialog box 

Click on the OK button 

 
MERCI also allows you to delete a user. 

To delete a User: 

1. Open the MERCI USERS dialog box as directed above. 

2. Select the User you want to delete by clicking on the  button 
and then clicking on the User’s name. 

3. Click on the Delete button. 

4. A confirmation message will appear. To continue deleting the 
user, click on the Yes button, to cancel, click on the No button. 
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You have deleted a user from the database. You can stay in this dialog box 
and delete as many users as you need. When you are done deleting you have 
three options: 
 

To Do this 

Add a New User See above 

Edit a User See above 

Exit the MERCI USERS 
dialog box 

Click on the OK button 

5.2 Ibar Observation Mode Scenarios 
A variety of different observation modes can be employed to estimate Ibar 
(numerator in Equation 4). Relatively instantaneous modes of observation are 
preferable. MERCI allows you to create, edit, or delete instantaneous 
observation mode scenarios. These scenarios indicate which modes of 
observation will be pooled to generate a particular management units Ibar 
estimate. 

To open the OBSERVATION MODES USED TO ESTIMATE IBAR dialog 
box: 

1. From the Edit menu, choose Estimation. 

2. Click on Ibar Observation Mode Scenarios. 
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To add a New Instantaneous Observation Mode Scenario: 

1. Open the OBSERVATION MODES USED TO ESTIMATE IBAR dialog 
box as directed above. 

2. Click on the New button. 

3. Type in the Observation mode scenario name in the Instan-
taneous observation mode scenarios field. 

Tip: When creating a new scenario, it is a very good idea 
indicate the observation modes used in the name of the 
scenario. 

4. Select the Observation mode(s) used by clicking in the box 
next to the name of the mode in the Observation modes used 
field. The modes included in the scenario will have a check 
mark in the box. 

5. Click on the Apply button. Note: To cancel adding the scenario, 
click on the Cancel button. 

 
You will have added a new scenario to the database. You can stay in this 
dialog box and enter in as many new scenarios as you need. When you are 
done adding new scenarios you have three options: 
 

To Do this 

Edit a Scenario See below 

Delete a Scenario See below 

Exit  Click on the OK button 

 
 
MERCI allows you to edit the observation modes in an Instantaneous 
Observation Mode Scenario. You can not edit the name of the mode. Should 
this be required, simply delete the scenario and then create a new scenario 
with the appropriate name and observation mode(s). 

To edit an Instantaneous Observation Mode Scenario: 

1. Open the OBSERVATION MODES USED TO ESTIMATE IBAR dialog 
box as directed above. 

2. Select the Scenario you want to edit by clicking on the  
button in the Instantaneous Observation mode scenarios field 
and then clicking on the Scenario. 

3. Click on the Edit button. 
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4. Click in the boxes next to the names of the modes you want to 
include or remove in the Observation modes used field. 

5. Click on the Apply button. Note: To cancel editing the scenario, 
click on the Cancel button. 

 
You have edited an Instantaneous Observation Mode Scenario in the 
database. You can stay in this dialog box and edit as many Scenarios as you 
need. When you are done editing you have three options: 
 

To Do this 

Add a Scenario See above 

Delete a Scenario See below 

Exit  Click on the OK button 

 
MERCI also allows you to delete an Instantaneous Observation Mode 
Scenario. 

To delete an Instantaneous Observation Mode Scenario: 

1. Open the OBSERVATION MODES USED TO ESTIMATE IBAR dialog 
box as directed above. 

2. Select the Scenario you want to delete by clicking on the  
button and then clicking on the Scenario. 

3. Click on the Delete button. 

4. A confirmation message will appear. To continue deleting, click 
on the Yes button, to cancel, click on the No button. 

 
You have deleted a scenario from the database. You can stay in this dialog 
box and delete as many scenarios as you need. When you are done deleting 
you have three options: 
 

To Do this 

Add a New Scenario See above 

Edit a Scenario See above 

Exit  Click on the OK button 
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5.3 Pbar Aggregation Scenarios 
A variety of data aggregation options can be employed when estimating Pbar 
- the proportion of nets fishing in the time period(s) during which 
instantaneous gear observations were made (Equation 5). The information 
from 24-hour access site effort monitoring surveys are used to calculate Pbar 
for each Management Unit. You can create a new Pbar Aggregation Scenario 
and edit or delete an existing Scenario. 

To open the PBAR AGGREGATION SCENARIOS dialog box: 

1. From the Edit menu, choose Estimation. 

2. Click on Pbar Aggregation Scenarios. 

 

 

To add a New Aggregation Scenario: 

1. Open the PBAR AGGREGATION SCENARIOS dialog box as 
directed above. 

2. Click on the New button. 

3. Type in the aggregation scenario name in the 24-hour access 
site aggregation scenario field. 

4. Type in a description name in the Description field. 

5. Select the Management Unit you want to use by clicking on 
the  button and then clicking on the Management Unit. 
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6. The next step is to select the Access Sites that will be used to 
produce the estimate of Pbar for the selected Management Unit. 

To  Do this 

Add an Access 
Site Name 

Click on the Access Site in the All Access 
site name: list on the left and click on the 
Add button or double-click on the site name 

Remove an 
Access Site 
Name 

Click on the Selected Access sites list on the 
right and click on the Remove button or 
double-click on the site name 

7. Click on the Apply button. Note: To cancel adding the scenario, 
click on the Cancel button. 

 
You have added a new scenario to the database. You can stay in this dialog 
box and enter in as many new scenarios as you need. When you are done 
adding new scenarios you have three options: 
 

To Do this 

Edit a Scenario See below 

Delete a Scenario See below 

Exit  Click on the OK button 

 
 
MERCI allows you to edit a scenario. You can edit the name of the scenario, 
the description, the Management Unit and the access sites included in the 
scenario. However, once output is associated with the scenario, you will not 
be able to edit the scenario (this allows you to determine the assumptions 
associated with the output in the database). 

To edit a Pbar Aggregation Scenario: 

1. Open the PBAR AGGREGATION SCENARIOS dialog box as 
directed above. 

2. Select the Scenario you want to edit by clicking on the  
button in the 24-hour access site aggregation scenario field and 
then clicking on the Scenario. 

3. Click on the Edit button. 

4. Type in the information you want to change in the appropriate 
fields. 

5. Click on the Apply button. Note: To cancel editing the scenario, 
click on the Cancel button. 
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You have edited an Aggregation Scenario in the database. You can stay in 
this dialog box and edit as many Scenarios as you need. When you are done 
editing you have three options: 
 

To Do this 

Add a New Scenario See above 

Delete a Scenario See below 

Exit  Click on the OK button 

 
MERCI also allows you to delete an Aggregation Scenario. Again, once 
output is associated with the scenario, you will not be able to delete the 
scenario. 

1. Open the PBAR AGGREGATION SCENARIOS dialog box as 
directed above. 

2. Select the Scenario you want to delete by clicking on the  
button in the 24-hour access site aggregation scenario field and 
then clicking on the Scenario. 

3. Click on the Delete button. 

4. A confirmation message will appear. To continue deleting, click 
on the Yes button, to cancel, click on the No button. 

 
You have deleted a scenario from the database. You can stay in this dialog 
box and delete as many scenarios as you need. When you are done deleting 
you have three options: 
 

To Do this 

Add a New Scenario See above 

Edit a Scenario See above 

Exit  Click on the OK button 

5.4 Cpue Estimator Definitions 
The CPUE ESTIMATOR SCENARIOS dialog box allows you to add, edit or 
delete Cpue estimator scenarios available to the model. There are two Cpue 
estimators – the ratio of means (Equation 2) and the mean of individual ratios 
(Equation 3). You can also exclude interviews from the catch estimation 
where the reported trip length is less than a specified duration. This is often 
recommended when applying Equation 3 to roving survey information. 
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These estimator definitions (or scenarios) form the list of available Cpue 
estimators for association with the different modes of contact used in the 
creel survey. 

To open the CPUE ESTIMATOR SCENARIOS dialog box: 

1. From the Edit menu, choose Estimation. 

2. Click on Cpue Estimator Definitions. 
 

 
 

To add a New Cpue Estimator Scenario: 

1. Open the CPUE ESTIMATOR SCENARIOS dialog box as directed 
above. 

2. Click on the New button. 

3. Type in the Cpue Estimator Scenario name in the Cpue 
estimator scenarios field. 

4. Click on the desired Cpue Estimator in the Cpue estimators 
field. 

5. Type in the minimum trip length that you would like excluded 
(in units of minutes) in the Trip durations excluded (minutes) 
field. 

6. Click on the Apply button. Note: To cancel adding the scenario, 
click on the Cancel button. 

 
You have added a new scenario to the database. You can stay in this dialog 
box and enter in as many new scenarios as you need. When you are done 
adding new scenarios you have three options: 
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To Do this 

Edit a Scenario See below 

Delete a Scenario See below 

Exit  Click on the OK button 

 

To edit a Cpue Estimator Scenario: 

1. Open the CPUE ESTIMATOR SCENARIOS dialog box as directed 
above. 

2. Select the Scenario you want to edit by clicking on the  
button in the Cpue estimator scenarios field and then clicking 
on the Scenario. 

3. Click on the Edit button. 

4. Change the information in the appropriate fields. 

5. Click on the Apply button. Note: To cancel editing the scenario, 
click on the Cancel button. 

 
You have edited a Cpue Estimator Scenario in the database. You can stay in 
this dialog box and edit as many Scenarios as you need. When you are done 
editing you have three options: 
 

To Do this 

Add a New Scenario See above 

Delete a Scenario See below 

Exit  Click on the OK button 

 
MERCI also allows you to delete a scenario. Once you have defined a 
scenario and generated output, you will not be able to delete the scenario. 

To delete a Cpue Estimator Scenario: 

1. Open the CPUE ESTIMATOR SCENARIOS dialog box as directed 
above. 

2. Select the Scenario you want to edit by clicking on the  
button in the Cpue estimator scenarios field and then clicking 
on the Scenario. 

3. Click on the Delete button. 

4. A confirmation message will appear. To continue deleting, click 
on the Yes button, to cancel, click on the No button. 
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You have now deleted a scenario from the database. You can stay in this 
dialog box and delete as many scenarios as you need. When you are done 
deleting you have three options: 
 

To Do this 

Add a New Scenario See above 

Edit a Scenario See above 

Exit  Click on the OK button 

5.5 Contact Method – Cpue Estimator 
Definitions 
Considerable debate often surrounds the appropriate ratio estimators for 
Cpue. A key issue is whether the probability of encountering fishers is equal 
or unequal. Different modes of contacting fishers can effect this sampling 
probability. For this reason, MERCI gives you the flexibility to associate 
different Cpue estimators with the different modes of contact used in the 
creel survey. 

To open the CONTACT METHOD – CPUE ESTIMATOR DEFINITIONS dialog 
box: 

1. From the Edit menu, choose Estimation. 

2. Click on Contact Method – Cpue Estimator Definitions. 
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To add a New Contact method – Cpue estimator scenario: 

1. Open the CONTACT METHOD – CPUE ESTIMATOR DEFINITIONS 
dialog box as directed above. 

2. Click on the New button. 

3. Type in the Cpue scenario name in the Contact method – Cpue 
scenario field. 

4. Type in a description name in the Description field. 

5. Select the different Interview Contact Methods by clicking on 
the  button and then clicking on the Method. 

6. The next step is to select the Cpue Estimator used to estimate 
the Cpue for the chosen contact method. 

To  Do this 

Add a Cpue 
Estimator 

Click on the Estimator in the All Estimators: 
list on the left and click on the Add button or 
double-click on the Estimator 

Remove a Cpue 
Estimator 

Click on the Selected Estimators list on the 
right and click on the Remove button or 
double-click on the estimator 

7. Click on the Apply button. Note: To cancel adding the 
estimator, click on the Cancel button. 
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You have added a new scenario to the database. You can stay in this dialog 
box and enter in as many new scenarios as you need. When you are done 
adding new scenarios you have three options: 
 

To Do this 

Edit a Scenario See below 

Delete a Scenario See below 

Exit  Click on the OK button 

 
 
MERCI allows you to edit a scenario. You can edit the name of the scenario, 
the description, the interview contact method and the estimators. Once you 
have generated output using a scenario, you will not be able to make changes 
to it. 

To edit a Contact method – Cpue estimator scenario: 

1. Open the CONTACT METHOD – CPUE ESTIMATOR DEFINITIONS 
dialog box as directed above. 

2. Select the Scenario you want to edit by clicking on the  
button in the Contact method – Cpue scenario field and then 
clicking on the Scenario. 

3. Click on the Edit button. 

4. Type in the information you want to change in the appropriate 
fields. 

5. Click on the Apply button. Note: To cancel editing the scenario, 
click on the Cancel button. 

 
You have now edited a Scenario in the database. You can stay in this dialog 
box and edit as many Scenarios as you need. When you are done editing you 
have three options: 
 

To Do this 

Add a New Scenario See above 

Delete a Scenario See below 

Exit  Click on the OK button 

 
MERCI also allows you to delete a Scenario. Once you have defined a 
scenario and generated output, you will not be able to delete the scenario. 
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To delete a Contact method – Cpue estimator scenario: 

1. Open the CONTACT METHOD – CPUE ESTIMATOR DEFINITIONS 
dialog box as directed above. 

2. Select the Scenario you want to edit by clicking on the  
button in the Contact method – Cpue scenario field and then 
clicking on the Scenario. 

3. Click on the Delete button. 

4. A confirmation message will appear. To continue deleting, click 
on the Yes button, to cancel, click on the No button. 

 
You have deleted a scenario from the database. You can stay in this dialog 
box and delete as many users as you need. When you are done deleting you 
have three options: 
 

To Do this 

Add a New Scenario See above 

Edit a Scenario See above 

Exit  Click on the OK button 

5.6 Cpue Aggregation Scenarios 
Cpue Aggregation Scenarios are equivalent to the Pbar Aggregation 
Scenarios except they control the rules for pooling of catch interviews among 
Management Units (e.g., use catch interviews from MU x, y, and z when 
computing MU x’s catch rate vs. only use catch interviews from MU x when 
computing MU x’s catch rate). Spatial pooling of catch interviews is often 
required when there is not enough information obtained from within 
individual Management Unit’s to produce its Cpue estimate. You can create 
a new Cpue Aggregation Scenario and edit or delete an existing Scenario. 

To open the CPUE AGGREGATION SCENARIOS dialog box: 

1. From the Edit menu, choose Estimation. 

2. Click on Cpue Aggregation Scenarios. 
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To add a New Aggregation Scenario: 

1. Open the CPUE AGGREGATION SCENARIOS dialog box as 
directed above. 

2. Click on the New button. 

3. Type in the aggregation scenario name in the Cpue 
aggregation scenario field. 

4. Type in a description name in the Description field. 

5. Select the primary Management Unit you want to use by 
clicking on the  button and then clicking on the 
Management Unit. 

6. The next step is to select additional Management Units for the 
scenario. 

To  Do this 

Add a 
Management 
Unit 

Click on the Management Unit in the All 
management unit names: list on the left and 
click on the Add button or double-click on 
the name 

Remove a 
Management 
Unit 

Click on the Selected management units list 
on the right and click on the Remove button 
or double-click on the site name 
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7. Click on the Apply button. Note: To cancel adding the scenario, 
click on the Cancel button. 

 
You have added a new scenario to the database. You can stay in this dialog 
box and enter in as many new scenarios as you need. When you are done 
adding new scenarios you have three options: 
 

To Do this 

Edit a Scenario See below 

Delete a Scenario See below 

Exit  Click on the OK button 

 
 
MERCI allows you to edit a scenario. You can edit the name of the scenario, 
the description, the scenario and the Management Units that are a part of the 
scenario. Once you have defined a scenario and generated output, you will 
not be able to edit the scenario. 

To edit an Aggregation Scenario: 

1. Open the CPUE AGGREGATION SCENARIOS dialog box as 
directed above. 

2. Select the Scenario you want to edit by clicking on the  
button in the Cpue aggregation scenario field and then clicking 
on the Scenario. 

3. Click on the Edit button. 

4. Type in the information you want to change in the appropriate 
fields. 

5. Click on the Apply button. Note: To cancel editing the scenario, 
click on the Cancel button. 

 
You have edited an Aggregation Scenario in the database. You can stay in 
this dialog box and edit as many Scenarios as you need. When you are done 
editing you have three options: 
 

To Do this 

Add a New Scenario See above 

Delete a Scenario See below 

Exit  Click on the OK button 
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MERCI also allows you to delete an Aggregation Scenario. Once you have 
defined a scenario and generated output, you will not be able to delete the 
scenario. 

To delete an Aggregation Scenario: 

1. Open the CPUE AGGREGATION SCENARIOS dialog box as 
directed above. 

2. Select the Scenario you want to delete by clicking on the  
button in the Cpue aggregation scenario field and then clicking 
on the Scenario. 

3. Click on the Delete button. 

4. A confirmation message will appear. To continue deleting, click 
on the Yes button, to cancel, click on the No button. 

 
You have deleted a scenario from the database. You can stay in this dialog 
box and delete as many scenarios as you need. When you are done deleting 
you have three options: 
 

To Do this 

Add a New Scenario See above 

Edit a Scenario See above 

Exit  Click on the OK button 

5.7 Confidence Intervals 
Bias corrected, log-transformed Bootstrap confidence intervals are produced 
by MERCI by selecting the Bootstrap estimate type on the ESTIMATOR 
DEFINITIONS dialog box (described in section Chapter 6). With additional 
resources, future versions of MERCI may also provide Taylor Series 
approximations under this menu. 
 
Resources were not available to provide a write-up of the bootstrap algorithm 
that was used.  This can be provided at a future date if desired. 
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CHAPTER 6 

Runs 

The Runs chapter provides information on the features found under the RUN 
– ESTIMATE menu. This menu item allows you to initiate the algorithms of 
the model used to estimate catch. This is where you specify the combination 
of scenarios described in Chapter 5, that will be used to estimate the 
components of Equation 1 and where you define the scope of the run (i.e., 
number of gear types, species, and weeks to estimate catch for). 
 
You can also choose the type of estimate – point (no standard error and 
confidence limit estimates) or bootstrap (provides standard error and bias 
corrected confidence limit estimates). The bootstrap estimation method 
should be used when you want confidence intervals for the weekly catch 
estimates. The point estimate method is used when you simply want to 
generate the best estimate of the catch (considerably less run time). You can 
also choose to use the scenarios that were defined in Chapter 5. 
 
The ESTIMATOR DEFINITIONS dialog box allows you to create a new estimate 
definition and edit or delete exiting estimate definitions. 

To open the ESTIMATOR DEFINITIONS dialog box: 

• From the File menu, choose Estimation. 
Or 

• Press F5 from the MERCI Window. 
 



90 Ch. 6 – Runs MERCI User’s Guide (Draft) 

Revision date: June 25, 1999 

 
 

To add a new estimate definition: 

1. Open the ESTIMATOR DEFINITIONS dialog box as directed above. 

2. Click on the New button. 

3. Type in the estimate definition name in the Available estimate 
definitions field. 

4. Type in the description in the field below the Available estimate 
definitions field. 

5. Click on the Areas of interest tab. 

6. Click in the boxes next to the names of the Management Units 
you want to include or remove in the Areas of interest tab. The 
Management Units included will have a check mark in the box. 

7. Click on the Gear of interest tab. 
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8. Click in the boxes next to the names of the gear types you want 
to include or remove. 

9. Click on the Species of interest tab. 

10. Click in the boxes next to the names of the fish species you want 
to include or remove. 

11. Click on the Dates of interest tab. 

12. To enter the time frame for the estimate, click on the  button 
next to the week ending field to bring up the MANAGEMENT 
WEEK FINDER dialog box. 
- Select the month and year of the fishing period from drop 

down list. 
- Click on the last day (Sunday) of the week of interest. Please 

ensure that the day button is depressed. 
- Click on the OK button. Note: To cancel, click on the Cancel 

button. 
- Repeat for the to field. 
- Note: The calendar year will automatically appear. 

13. Choose Weekly estimates or Aggregate survey data over time 
by clicking in the appropriate circle next to the text. 

14. Select the Estimate type you want to use by clicking on the  
button in the Estimate type field and then clicking on the 
Estimate name. The bootstrap estimate method is used when 
you want standard error and confidence interval estimates for the 
statistics in Equation 1. The point estimate method is used when 
you want to generate the best estimate of the catch. 

15. If you chose the Bootstrap option, go to step 16. If you chose the 
Point Estimates option, go to step 19. 

16. Click on the  button to get to the BOOTSTRAP REPLICATIONS 
dialog box. 

17. Type in the number of bootstrap replications. 

18. Click on the OK button. Note: To cancel, click on the Cancel 
button. 

19. Select the User by clicking on the  button in the Author field 
and then clicking on the User name. The  button takes you to 
the MERCI USERS dialog box where you can add a new user, edit 
or delete an existing user. This is described in more detail in 
Section 5.1. 

20. Click on the Effort tab. 
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21. Select the Instantaneous observation mode scenario by 
clicking on the  button in the Instantaneous observation 
mode(s) field and then clicking on the scenario. The  button 
takes you to the OBSERVATION MODES USED TO ESTIMATE IBAR 
dialog box where you can add a new scenario, edit or delete an 
existing scenario. This is described in more detail in Section 5.2. 

22. Select the Pbar aggregation scenario by clicking on the  
button in the 24-hour access site aggregation scenario field and 
then clicking on the scenario. The  button takes you to the 
PBAR AGGREGATION SCENARIOS dialog box where you can add 
a new scenario, edit or delete an existing scenario. This is 
described in more detail in Section 5.3. 

23. Click on the Cpue tab. 

24. Select the approach by clicking on the  button in the Multi-
estimator approach field and then clicking on the approach 
name. 

These two different estimation approaches are described in 
detail in: 

Alexander, C. A. D. 1999. 1998 Native Catch Estimates 
on the Upper Fraser River. Prepared by ESSA 
Technologies Ltd., Vancouver, BC for the Department 
of Fisheries and Oceans, Fraser River Division, Annacis 
Island, New Westminster, BC. 68 pp. and appendices. 

This report can be found on the MERCI installation CD. 

25. Select the Contact method –estimator definition by clicking on 
the  button in the Contact method –estimator definition field 
and then clicking on the definition. The  button takes you to 
the CONTACT METHOD – CPUE ESTIMATOR SCENARIOS dialog 
box where you can add a new scenario, edit or delete an existing 
scenario. This is described in more detail in Section 5.5. 

26. Select the Catch interview aggregation scenario by clicking on 
the  button in the Catch interview aggregation scenario field 
and then clicking on the scenario. The  button takes you to 
the CPUE AGGREGATION SCENARIOS dialog box where you can 
add a new scenario, edit or delete an existing scenario. This is 
described in more detail in Section 5.6. 
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27. Choose Off or On in the Override pooling of survey data among 
MUs by clicking in the appropriate circle next to the text. If you 
choose On, type in the threshold number of interviewers you 
would use to turn off aggregation (n). If On and MERCI finds at 
least n or more interviews were obtained from within the target 
Management Unit, catch interviews from other Management 
Units will not be used to compute the said Management Unit’s 
Cpue. 

28. Choose Ratio of Means or Mean of Ratios in the Preferred 
Cpue Estimator by clicking in the appropriate circle next to the 
text. When using the hierarchical method of estimation (HM 
method), this tells MERCI which Cpue estimate to use in 
calculating the catch when a Cpue estimate is available from the 
ratio of means and mean of ratios estimators. 

29. Click on the Apply button. Note: To cancel adding the estimate 
definition, click on the Cancel button. 

 
You have added a new estimate definition to the database. You can stay in 
this dialog box and enter in as many new definitions as you need. When you 
are done adding new definitions you have four options: 
 

To Do this 

Edit a Definition See below 

Delete a Definition See below 

Run an Estimate See below 

Exit  Click on the Close button 

 

To edit an estimate definition: 

1. Open the ESTIMATOR DEFINITIONS dialog box as directed above. 

2. Select the Definition you want to edit by clicking on the  
button in the Available estimate definitions field and then 
clicking on the Definition. 

3. Click on the Edit button. 

4. Change the information in the appropriate fields. 

5. Click on the Apply button. Note: To cancel editing, click on the 
Cancel button. 

 
You have edited an Estimate Definition in the database. You can stay in this 
dialog box and edit as many definitions as you need. When you are done 
editing you have four options: 
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To Do this 

Add a Definition See above 

Delete a Definition See below 

Run an Estimate See below 

Exit  Click on the Close button 

 
 
MERCI also allows you to delete an Estimate Definition and all of its 
associated output. 

To delete an estimate definition: 

1. Open the ESTIMATOR DEFINITIONS dialog box as directed 
above. 

2. Select the Definition you want to edit by clicking on the  
button in the Available estimate definitions field and then 
clicking on the Definition. 

3. Click on the Delete button. 

4. A confirmation message will appear. To continue deleting, click 
on the Yes button, to cancel, click on the No button. 

 
You have deleted an Estimate Definition and associated output from the 
database. You can stay in this dialog box and delete as many Estimate 
Definitions as you need. When you are done deleting you have four options: 
 

To Do this 

Add a New Definition See above 

Edit a Definition See above 

Run an Estimate See below 

Exit  Click on the Close button 

 

To run an estimate: 

1. Open the ESTIMATOR DEFINITIONS dialog box as directed 
above. 

2. Select the Definition you want to edit by clicking on the  
button in the Available estimate definitions field and then 
clicking on the Definition. 
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3. Click on the Run Estimates button. The run may take some 
time depending upon the estimate definition chosen. A message 
will appear indicating how many catch estimates are remaining. 

4. A message will appear indicating that the estimates are 
complete. Click on the OK button. 

 
Another message will appear indicating to click on View | Output for Output 
options when MERCI has finished all of the catch calculations. This is 
discussed in further detail in Chapter 7 – Model Output. 
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CHAPTER 7 

Model Output 

The Model Output chapter provides information on the features found under 
the VIEW – OUTPUT GRAPHS menu. This menu item allows you to query the 
output tables in the database to obtain printable on-screen graphs. Using the 
OUTPUT OPTIONS dialog box, you can also compare results between multiple 
estimation scenarios for any of six key statistics: 
 

• Catch; 
• Cpue; 
• Effort; 
• Ibar; and, 
• Pbar. 

 
Results are provided on a species by species basis, for any combination of 
gear types, weeks, and management units. The OUTPUT OPTIONS dialog box 
also allows you to specify the alpha level for showing confidence limits on 
weekly estimates for these 6 statistics. 
 
Unfortunately, resources were not available to provide output tables for 
automating weekly catch reporting. These features could be made available 
in a future release of MERCI. 
 
The remainder of this chapter describes the features of: 
 

• the OUTPUT OPTIONS dialog box; and, 
• the MERCI OUTPUT GRAPHS viewer. 

7.1 Output Options 
The OUTPUT OPTIONS dialog box is a tool that allows you to query the 
results of different estimation scenarios. It can be accessed directly from the 
MERCI Menu or by clicking on the Output Graphs button on the MERCI 
Toolbar. 
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To open the OUTPUT OPTIONS dialog box: 

• From the View menu, click on Output Graphs 
Or 

• From the main MERCI screen click on the  button. 
 

 
 
This dialog box lets you display output statistics over Time (weeks) and by 
Location. You can also compare the results of different estimation scenarios 
by clicking more than one scenario in the Compare results for scenarios list 
box. You simply have to specify the species, gear types, weeks, and 
management units from which you would like to see the chosen output 
statistics. 
 
Confidence limits are displayed over time for the estimation scenario 
identified in the Show confidence limits for scenario drop-down list. You 
set the precision of the confidence limits using the Alpha value drop-down 
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list. The Log transform data when computing confidence intervals? 
option allows you to log-transform the values of the statistic chosen on the 
Time tab. This helps to remove a certain form of skewness in the statistics 
distribution, which improves the accuracy of the endpoints that are found 
when calculating bootstrap confidence limits4. As a general rule, it is a good 
idea to make this transformation (should result in pseudo BCa bootstrap 
confidence interval). 
 
Note, the options under the Histogram tab are not enabled in MERCI 2.0. 
 
When you click on the OK button, MERCI builds and executes a query to 
obtain the output. For bootstrap estimates, these queries involve many 
calculations and i/o operations on the database. As a result, they are time 
consuming, so we recommend you have an analysis plan in mind before 
committing the query. 

7.2 The MERCI Output Graphs Viewer 
The results of the query defined with the OUTPUT OPTIONS dialog box are 
displayed within the MERCI OUTPUT GRAPHS viewer. 
 

 
 
The viewer automatically loads the first time you obtain results using the 
OUTPUT OPTIONS dialog box. Using the viewer, you can resize and print the 
results, and quickly jump back to OUTPUT OPTIONS dialog box to perform 
new queries. The Refresh option under the View menu re-runs the most 

                                                      
4 BC bootstrap confidence limits are computed following the methods outlined in chapters 13 and 14 of: Efron, B. and R. J. 

Tibshirani.  1993.  An Introduction to the Bootstrap.  Monographs on Statistics and Applied Probability, 57.  Chapman 
and Hall.  436 p.  
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recently defined query in the OUTPUT OPTIONS dialog box, in case you 
accidentally unloaded one of the output graphs. 
 
The File menu allows you to print the graphs. You can also quickly jump 
back to the OUTPUT DIALOG using the Windows task bar or by clicking the 
View | Output Dialog menu from within the MERCI OUTPUT GRAPHS 
viewer. 
 
 

Notes: 

• The Time graph cannot be shown for a single week. 
• The Location graph does not allow you to display data for a 

single management unit. 
• If a scenario name is very long, or multiple scenarios with long 

names are compared, the Location graph may give the error: 
“String value too long”. When this occurs, compare fewer 
scenarios, or shorten your scenario names. 
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CHAPTER 8 

The Database 

One of the major enhancements of MERCI 2.0 is its new, normalised 
Access 97 database (61 tables) with rules for enforced referential integrity. 
The non-normalised database for MERCI 1+ (4 tables!) was inherited from 
the estimation system in place prior to ESSA’s involvement. However, the 
MERCI 2.0 database is compatible (i.e., supports file importing from MERCI 
1.0 databases to MERCI 2.0 databases) with the MERCI 1.0 database design. 
The redesign of the MERCI 1+ database was critical to allow efficient 
estimation, integration of input and output, give more flexible editing 
features, and to help reduce data entry and estimation anomalies. 
 
This chapter contains the following sections: 
 

• The Catch and Effort Explorer 
• The Structure of the Database 

8.1 The Catch and Effort Explorer 
The CATCH AND EFFORT EXPLORER is a tool that allows you to explore the 
survey data that is currently entered in the active MERCI database. The 
CATCH AND EFFORT EXPLORER can be accessed directly from the MERCI 
Menu or through any of the four DATA ENTRY dialog boxes. 

To open the CATCH AND EFFORT EXPLORER from the MERCI Menu: 

• From the View menu, choose Open Database and click on 
Explore; or 

• Click on the  button; or 
• From the MERCI window, hold down the Ctrl key and press the 

D key. 
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To open the CATCH AND EFFORT EXPLORER from the other dialog 
boxes: 
The FRASER RIVER FISHERY OPENINGS dialog box is used here to 
demonstrate. Follow the exact same procedure from any of the four DATA 
ENTRY dialog boxes. 
 

1. From the Edit Menu, choose Data Entry. 

2. Click on Fishery Openings. 

3. From the Explore Menu, choose Database or hold down the 
Ctrl key and press the D key. 

 
 
The CATCH AND EFFORT EXPLORER has two panes. The pane on the left 
displays the name of the database that is open and a list of the legacy tables 
that are in the database (i.e., the basic tables carried over from the 
pre-MERCI estimation system).  Because these database tables were 
essentially laid out like a spreadsheet, they can be viewed on screen. 
 
The four legacy tables correspond to the four DATA ENTRY dialog boxes in 
MERCI. 
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Table Dialog Box 

AreaOpenings FRASER RIVER FISHERY OPENINGS 

CatchSurveys CATCH INTERVIEWS 

EffortProfiles 24-HOUR EFFORT SURVEYS 

GearCounts MU GEAR COUNTS 

 
 
There are a number of functions you can perform from the left pane. 
 

To Do This 

View all fields in a 
table 

Click on the plus sign beside the table name 

Hide all fields in a 
table 

Click on the minus sign beside the table name 

Populate the right 
pane with records 
for that table 

Click on the table name with the left mouse button 

Add a new record Click on the table name with the right mouse button 
and click on Add New Record. This will bring you to 
the corresponding ADD NEW MODE dialog box. You 
can add a new record as outlined in Sections 4.1.1, 
4.2.1, 4.3.1 and 4.4.1. 

Modify an 
existing record 

Click on the table name with the right mouse button 
and click on Modify Existing Record. This will bring 
you to the corresponding EDIT/DELETE EXISTING 
MODE dialog box. You can now search for the record 
to modify as outlined in Sections 4.1.2, 4.2.2, 4.3.2 
and 4.4.2. 

 
 
Tip: 
To avoid repeated re-population of the database (which may be time 
consuming), use the EXPLORER to find a record, then jump to that program 
components data entry form (by choosing Modify Existing Record, close 
the EXPLORER, then modify or delete from the data entry form. 
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The pane on the right contains columns that correspond to the list under the 
tables in the left pane. As with the left pane, there are a number of functions 
you can perform from the right pane. 
 

To Do This 

Sort alphabetically 
by column 

Click on the column name title button 
( ). If you want to sort in reverse 
alphabetical order, click once more. 

Change the width 
of the column 

Move the cursor to the right side of the column name 
title button until it changes to . Double-click and 
hold down the left mouse button and then drag the 
column to the desired width. 

Delete a record Click on the  icon with the right mouse button and 
click on Delete Record. This will bring up a 
confirmation screen for the delete function.  

Modify an 
existing record 

Click on the  icon with the right mouse button and 
click on Modify Existing Record. This will open the 
record in the corresponding EDIT/DELETE EXISTING 
MODE dialog box. You can now modify the record as 
outlined in Sections 4.1.2, 4.2.2, 4.3.2 and 4.4.2. 

 

Warning! 

Deleting all of the records in a table using MERCI will cause 
the application to fail. Delete unwanted entries only when one 
or more other records exist. 

 

To Switch your Database: 

1. From the File menu, choose Switch Database. 

2. Select the required database and click on Open. 

To Exit the CATCH AND EFFORT EXPLORER: 

• From the File menu, choose Close; or 

• Click on the  button. 
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8.2 The Structure of the Database 
Resources were not available to complete a write-up for the database. A 
detailed write-up of the database structure may be provided at a later time if 
desired. 
 
As a courtesy, the developer offers the following important insights and 
guidelines: 
 

• NEVER delete or rename any of the tables, modules, or queries 
supplied in the original database. 

• NEVER delete or modify any of the relationships or referential 
integrity rules supplied in the original database. 

• NEVER change the design (i.e., rename or change the position of 
fields, add fields) of the tables, modules, or queries supplied in 
the original database. 

• BECOME VERY FAMILIAR WITH 
“tblOUTPUT_SpecialCasesToReview”. This table contains a 
list of cases for which you requested a catch estimate, but for 
which there was insufficient information to estimated one or more 
of: Cpue, Ibar, or Pbar. In most cases, random sampling variation 
or inadequate sampling effort account for the lack of a catch 
estimate in the strata in question. Failure to manually correct for 
these cases will lead to an underestimate of catch. 

• Do not modify the contents of top-level tables (e.g., tables which 
do not reference other tables, like 
“tblManagementUnitDescriptions”) unless you are certain of the 
consequences. 

• Do not modify the contents of any table unless you are certain of 
why you need to do it and you are able to accept the 
consequences. 

• MERCI makes extensive use of cascade delete and cascade 
update. Therefore, single changes in one table can have large 
consequences throughout any number of other tables. 

• Tables prefixed by “tblOUTPUT…” contain the model’s output 
information. Because MERCI’s automated output viewing options 
are limited, users needing to generate output reports will need to 
become familiar with these tables. The model could automate this 
process in a future version. 

• It is a good idea to become familiar with the structure and 
contents of table “tblESTIMATE_DEFINITION”. This table 
stores all of the information you specified on the Estimator 
Definitions dialog under RUN – ESTIMATE. It may be more 
convenient to delete scenarios from this table (which results in a 
cascade deletion of all associated output information) than from 
within MERCI when you want to reduce the size of the database. 
Preceding caveats about being sure of the consequences of your 
changes definitely remain in effect here. 
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• As is standard database convention, the MERCI 2.0 database 
relies on numeric ID’s rather than text ID’s. You will have to 
become familiar with these numeric ID’s (all of which are defined 
in top level tables in the database) when implementing your own 
queries (e.g., species “1” = sockeye; management unit “5” = 
Piglog Creek to Pooeyelth Creek; gear type “2” = dip nets; 24-
hour access site “3” = Elders site). 

• Should you need to add any tables to a database, be sure to prefix 
them with “tbl”. This is an internal cue used by MERCI to 
distinguish between legacy tables (no “tbl” prefix) and new tables 
(“tbl” prefix). 

• When estimating catch, MERCI uses information in: 
“tblCatchSurveys” not the legacy information in “CatchSurveys”; 
“tblAreaOpenings” not the legacy information in 
“AreaOpenings”; “tblEffortProfiles” not the legacy information in 
“Effort Profiles”; “tblGearCount” not the legacy information in 
“GearCounts”. 
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CHAPTER 9 

File Management 

MERCI offers Export and Import functions to enable you and other users to 
exchange raw survey data between different databases. Output information 
cannot be exchanged with Import and Export. You must have the database 
that you are exporting from or importing to open. 

To open a database: 

1. From the File menu, choose Open Database or click on the 
 button. 

2. Select the database and click on Open. 

9.1 Export 
MERCI allows you to export all records associated with one or more 
Management Units over a given time frame. The following procedure 
describes how to export a copy of the records into a new database. 

To export records: 

1. From the File menu, choose Export or from the MERCI 
window, hold down the Ctrl key and press the I key. 
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2. Select the month and year of the first day of the export period 
from drop down lists in the Start Date box. 

3. Click on the day of the month. Please ensure that the day button 
is depressed as in the above diagram. 

4. Select the month and year of the last day of the export period 
from drop down lists in the End Date box. 

5. Click on the day of the month. 

6. Select one or more Management Units by one of the following: 
- to select all Management Units, click on the Select All button 
- to select one Management Unit, click on the appropriate one in 

the Management Unit list to select or deselect. 
7. To multiple select Management Units, hold the Shift or Ctrl key 

and click on the appropriate Units. 

8. Click on the OK button. To cancel exporting these records, click 
on the Cancel button. 

 
The export could take some time depending on the size of the database, the 
length of the time period chosen and the number of Management Units. 
When complete, a dialog box will appear indicating that the export has been 
successfully completed. Click on OK to continue. If you look at your status 
bar, the database you just exported is now open. 
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9.2 Import 
The following procedure describes how to import a copy of existing records 
from another database to the database which is currently loaded when you 
click Import from the File menu. 

To import records: 

1. From the File menu, choose Import, or from the MERCI 
window, hold down the Ctrl key and press the I key. This brings 
you directly to the dialog box. 

2. Select the database you wish to import records from. 

3. Click on the Open button. Note: To cancel importing, click on 
the Cancel button. 

4. The MERCI DATABASE IMPORT dialog box will appear 
indicating the number of records that will be imported from the 
selected database. Click on the OK button to continue for the 
Cancel button to cancel importing. 

 

 
 
The import could take some time depending on the size of the database. 
When complete, a dialog box will appear indicating that the import has been 
successfully completed. Click on OK to continue. 
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9.3 Other File Management 
Suggestions 

1. The Bootstrap estimation method produces a tremendous 
amount of data which can cause the MERCI database to become 
fragmented. For this reason, you should compact the database 
once you have finished any extensive Bootstrap estimation. 
This must be done by opening Access, and choosing 
TOOLS|DATABASE UTILITIES|COMPACT DATABASE. This will 
usually result in a considerable reduction in the size of the .mdb 
file. 

2. Adopt a standard naming convention for you database files 
among MERCI users. 

3. Make frequent back-up copies of your databases. 


